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About this Guide

This section explains the objectives, intended audience, and organization of this publication and
describes the conventions that convey instructions and other information.

This section provides the following information:

Document Objectives

Audience

Document Organization

Related Documentation

Document Conventions

Where to Find Safety and Warning Information
Obtaining Documentation

Documentation Feedback

Obtaining Technical Assistance

Obtaining Additional Publications and Information

Document Objectives

This user guide explains how to design networks using the MetroPlanner design tool for the

Cisco ONS 15454 system. It contains information about how to design an optical network, the types of
available topologies, and some example designs. Use this user guide in conjunction with the appropriate
publications listed in the Related Documentation section.

Audience

This publication is intended for experienced network system engineers who are responsible for planning
and ordering equipment for Cisco optical networking systems.
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I Document Organization

Document Organization

This Cisco MetroPlanner DWDM Operations Guide, Release 2.5 is organized into the following
chapters:

e Chapter 1, “Overview” provides a list of features, an overview of the network design process, a
description of the internal architecture, and the MetroPlanner procedural flow.

e Chapter 2, “Designing Networks with MetroPlanner” provides instructions for using the
MetroPlanner tool to create a network design, and information about how to adjust and optimize
design components, and how to generate build reports and bills of materials.

e Chapter 3, “Modeled Network Examples” provides examples of typical optical networks you can
model using MetroPlanner.

e Appendix A, “Card Types” provides a listing of card types and the corresponding CCO card
description.

e Appendix B, “Troubleshooting” describes problems you may encounter using MetroPlanner, and
their possible solutions.

Related Documentation

Use this Cisco MetroPlanner DWDM Operations Guide, Release 2.5 in conjunction with the following
referenced publications:

e Cisco ONS 15454 Procedure Guide, R4.7—Provides procedures to install, turn up, provision, and
maintain a Cisco ONS 15454 node and network.

e Cisco ONS 15454 Reference Manual, R4.7—Provides reference material for Cisco ONS 15454
nodes and networks.

e Cisco ONS 15454 Troubleshooting Guide, R4.7—Provides general troubleshooting procedures,
alarm descriptions, and performance monitoring and SNMP information.

e Cisco ONS 15454 and Cisco ONS 15327 TLI Command Guide, Release 4.7—Provides test access
TL1 commands, configurations, and parameter types.

e Release Notes for the Cisco ONS 15454, R4.7—Provides caveats, closed issues, and new feature and
functionality information.

Document Conventions

This publication uses the following conventions:

Convention Application

boldface Commands and keywords in body text.

italic Command input that is supplied by the user.

[ 1] Keywords or arguments that appear within square brackets are optional.

Cisco MetroPlanner DWDM Operations Guide, Release 2.5
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~

Note

A

Where to Find Safety and Warning Information 1l

Convention Application

{xlxIx} A choice of keywords (represented by x) appears in braces separated by
vertical bars. The user must select one.

Ctrl The control key. For example, where Ctrl + D is written, hold down the
Control key while pressing the D key.

screen font Examples of information displayed on the screen.
boldface screen font  Examples of information that the user must enter.

< > Command parameters that must be replaced by module-specific codes.

Means reader take note. Notes contain helpful suggestions or references to material not covered in the
document.

Caution

A

Warning

Means reader be careful. In this situation, the user might do something that could result in equipment
damage or loss of data.

IMPORTANT SAFETY INSTRUCTIONS

This warning symbol means danger. You are in a situation that could cause bodily injury. Before you
work on any equipment, be aware of the hazards involved with electrical circuitry and be familiar
with standard practices for preventing accidents. To see translations of the warnings that appear in
this publication, refer to the translated safety warnings that accompanied this device.

Note: SAVE THESE INSTRUCTIONS

Note: This documentation is to be used in conjunction with the specific product installation guide
that shipped with the product. Please refer to the Installation Guide, Configuration Guide, or other
enclosed additional documentation for further details.

Where to Find Safety and Warning Information

For safety and warning information, refer to the Cisco Optical Transport Products Safety and
Compliance Information document that accompanied the product. This publication describes the
international agency compliance and safety information for the Cisco ONS 15454 systems. It also
includes translations of the safety warnings that appear in the ONS 15454 system documentation.
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I Obtaining Documentation

Obtaining Documentation

Cisco documentation and additional literature are available on Cisco.com. Cisco also provides several
ways to obtain technical assistance and other technical resources. These sections explain how to obtain
technical information from Cisco Systems.

Cisco.com

You can access the most current Cisco documentation at this URL:
http://www.cisco.com/univercd/home/home.htm

You can access the Cisco website at this URL:
http://www.cisco.com

You can access international Cisco websites at this URL:

http://www.cisco.com/public/countries_languages.shtml

Ordering Documentation

You can find instructions for ordering documentation at this URL:
http://www.cisco.com/univercd/cc/td/doc/es_inpck/pdi.htm
You can order Cisco documentation in these ways:

e Registered Cisco.com users (Cisco direct customers) can order Cisco product documentation from
the Ordering tool:

http://www.cisco.com/en/US/partner/ordering/index.shtml

e Nonregistered Cisco.com users can order documentation through a local account representative by
calling Cisco Systems Corporate Headquarters (California, USA) at 408 526-7208 or, elsewhere in
North America, by calling 1 800 553-NETS (6387).

Cisco Optical Networking Product Documentation CD-ROM

Optical networking-related documentation, including Cisco ONS 15454 product documentation, is
available in a CD-ROM package that ships with your product. The Optical Networking Product
Documentation CD-ROM is updated periodically and may be more current than printed documentation.

Documentation Feedback

You can send comments about technical documentation to bug-doc @cisco.com.

Cisco MetroPlanner DWDM Operations Guide, Release 2.5
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Obtaining Technical Assistance

You can submit comments by using the response card (if present) behind the front cover of your
document or by writing to the following address:

Cisco Systems

Attn: Customer Document Ordering
170 West Tasman Drive

San Jose, CA 95134-9883

We appreciate your comments.

Obtaining Technical Assistance

For all customers, partners, resellers, and distributors who hold valid Cisco service contracts, Cisco
Technical Support provides 24-hour-a-day, award-winning technical assistance. The Cisco Technical
Support Website on Cisco.com features extensive online support resources. In addition, Cisco Technical
Assistance Center (TAC) engineers provide telephone support. If you do not hold a valid Cisco service
contract, contact your reseller.

Cisco Technical Support Website

Note

The Cisco Technical Support Website provides online documents and tools for troubleshooting and
resolving technical issues with Cisco products and technologies. The website is available 24 hours a day,
365 days a year, at this URL:

http://www.cisco.com/techsupport

Access to all tools on the Cisco Technical Support Website requires a Cisco.com user ID and password.
If you have a valid service contract but do not have a user ID or password, you can register at this URL:

http://tools.cisco.com/RPF/register/register.do

Use the Cisco Product Identification (CPI) tool to locate your product serial number before submitting
a web or phone request for service. You can access the CPI tool from the Cisco Technical Support
Website by clicking the Tools & Resources link under Documentation & Tools. Choose Cisco Product
Identification Tool from the Alphabetical Index drop-down list, or click the Cisco Product
Identification Tool link under Alerts & RMAs. The CPI tool offers three search options: by product ID
or model name; by tree view; or for certain products, by copying and pasting show command output.
Search results show an illustration of your product with the serial number label location highlighted.
Locate the serial number label on your product and record the information before placing a service call.

Submitting a Service Request

Using the online TAC Service Request Tool is the fastest way to open S3 and S4 service requests. (S3
and S4 service requests are those in which your network is minimally impaired or for which you require
product information.) After you describe your situation, the TAC Service Request Tool provides
recommended solutions. If your issue is not resolved using the recommended resources, your service
request is assigned to a Cisco TAC engineer. The TAC Service Request Tool is located at this URL:

http://www.cisco.com/techsupport/servicerequest
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M Definitions of Service Request Severity

For S1 or S2 service requests or if you do not have Internet access, contact the Cisco TAC by telephone.
(ST or S2 service requests are those in which your production network is down or severely degraded.)
Cisco TAC engineers are assigned immediately to S1 and S2 service requests to help keep your business
operations running smoothly.

To open a service request by telephone, use one of the following numbers:

Asia-Pacific: +61 2 8446 7411 (Australia: 1 800 805 227)
EMEA: +32 2 704 55 55
USA: 1800 553-2447

For a complete list of Cisco TAC contacts, go to this URL:

http://www.cisco.com/techsupport/contacts

Definitions of Service Request Severity

To ensure that all service requests are reported in a standard format, Cisco has established severity
definitions.

Severity 1 (S1)—Your network is “down,” or there is a critical impact to your business operations. You
and Cisco will commit all necessary resources around the clock to resolve the situation.

Severity 2 (S2)—Operation of an existing network is severely degraded, or significant aspects of your
business operation are negatively affected by inadequate performance of Cisco products. You and Cisco
will commit full-time resources during normal business hours to resolve the situation.

Severity 3 (S3)—Operational performance of your network is impaired, but most business operations
remain functional. You and Cisco will commit resources during normal business hours to restore service
to satisfactory levels.

Severity 4 (S4)—You require information or assistance with Cisco product capabilities, installation, or
configuration. There is little or no effect on your business operations.

Obtaining Additional Publications and Information

Information about Cisco products, technologies, and network solutions is available from various online
and printed sources.

¢ Cisco Marketplace provides a variety of Cisco books, reference guides, and logo merchandise. Visit
Cisco Marketplace, the company store, at this URL:

http://www.cisco.com/go/marketplace/

e The Cisco Product Catalog describes the networking products offered by Cisco Systems, as well as
ordering and customer support services. Access the Cisco Product Catalog at this URL:

http://cisco.com/univercd/cc/td/doc/pcat/

e (isco Press publishes a wide range of general networking, training and certification titles. Both new
and experienced users will benefit from these publications. For current Cisco Press titles and other
information, go to Cisco Press at this URL:

http://www.ciscopress.com

¢ Packet magazine is the Cisco Systems technical user magazine for maximizing Internet and
networking investments. Each quarter, Packet delivers coverage of the latest industry trends,
technology breakthroughs, and Cisco products and solutions, as well as network deployment and
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Obtaining Additional Publications and Information

troubleshooting tips, configuration examples, customer case studies, certification and training
information, and links to scores of in-depth online resources. You can access Packet magazine at
this URL:

http://www.cisco.com/packet

iQ Magazine is the quarterly publication from Cisco Systems designed to help growing companies
learn how they can use technology to increase revenue, streamline their business, and expand
services. The publication identifies the challenges facing these companies and the technologies to
help solve them, using real-world case studies and business strategies to help readers make sound
technology investment decisions. You can access iQ Magazine at this URL:

http://www.cisco.com/go/igmagazine

Internet Protocol Journal is a quarterly journal published by Cisco Systems for engineering
professionals involved in designing, developing, and operating public and private internets and
intranets. You can access the Internet Protocol Journal at this URL:

http://www.cisco.com/ipj

World-class networking training is available from Cisco. You can view current offerings at
this URL:

http://www.cisco.com/en/US/learning/index.html
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CHAPTER 1

Overview

Cisco MetroPlanner 2.5 provides a means to construct and test wavelength division multiplexing (WDM)
optical networks in a modelled graphical environment. Well-designed optical networks can take
advantage of the availability of dark fiber to build a common infrastructure that supports data, storage
area network (SAN), and time-division multiplexing (TDM) traffic.

The primary purpose of MetroPlanner is to assist sales engineers (SEs) in the design and validation of
optical networking deployment using Cisco Optical Networking System (ONS) 15454 Multi-Service
Transport Platforms (MSTP). MetroPlanner generates a shelf view of all the sites deployed in the optical
network and provides a complete bill of materials (BOM) for the network.

This chapter describes how you use MetroPlanner to design, analyze, and optimize new or existing Cisco
optical networks.

This chapter contains the following sections:
e 1.1 MetroPlanner Features, page 1-1
e 1.2 Network Design Process, page 1-2
e 1.3 Internal Architecture, page 1-2
e 1.4 MetroPlanner Procedural Flow, page 1-4
e 1.5 Planning Traffic in MetroPlanner 2.5, page 1-5
e 1.6 Viewing Traffic in MetroPlanner 2.5, page 1-6

1.1 MetroPlanner Features

MetroPlanner 2.5 provides a simple tool set for designing optical networks with Cisco ONS 15454
MSTP products. By entering specific configurations, or only the barest essentials of site distances, you
can make the correct choices for the type of network you wish to build. Several solutions can correspond
to one type of equipment or platform. The MetroPlanner 2.5 graphical user interface (GUI) models
general specifications and produces detailed BOMs to provision optimized networks.

Designing optical networks requires the verification of multiple constraints such as optical budget
limitations and platform architectural constraints. Both simple and complex optical network designs are
automatically modelled and tested by MetroPlanner 2.5.
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1.2 Network Design Process

1.2 Network Design Process

The MetroPlanner 2.5 GUI allows SEs to design and document network designs and validate optical
networking implementations on the Cisco ONS 15454 MSTP platform. Using MetroPlanner 2.5, you can
perform the following tasks:

¢ Create network topologies

e Define network requirements (service demands, protection)

e Validate the network constraints (optical budget, receiver overload)

¢ Create corresponding BOMs and build reports
Using the MetroPlanner-generated BOM, you can place the order directly on Cisco.com.
The MetroPlanner 2.5 GUI allows the SE to do the following:

¢ Create a node at a site

e Interconnect sites with fiber spans

¢ Specify the requested service demands between nodes

e Define the type of protection scheme

1.2.1 Network Design Optimization

The total network cost is the cost of the equipment for all of the sites in the designed network.
MetroPlanner 2.5 searches for the best solution to a designed network using an optimization algorithm.

1.2.2 Network Design Constraints

A network design must meet the optical budget and receiver overload criteria to operate efficiently. The
analysis of optical budget and receiver overload evaluates the strength of the signal traversing the ring.
If a design solution satisfies the constraints, it is a valid design. The MetroPlanner 2.5 optimization
algorithms generate multiple solutions and verify the constraints against those solutions. If the
constraints are satisfied, the solution with the lowest cost-to-utilization ratio is selected as the optimal
solution.

If the network design solution fails to satisfy all the constraints, MetroPlanner 2.5 makes adjustments to
parameters such as signal attenuation and amplification. Amplification is achieved either by using an
erbium-doped fiber amplifier (EDFA). Attenuation is achieved by using variable optical attenuator
(VOA) modules integrated into the platform. MetroPlanner 2.5 corrects the optical budget using an
algorithm that includes automatic placement of EDFAs and VOA regulation.

For each internodal demand, MetroPlanner 2.5 performs an optical budget and receiver overload analysis
and the displays the results in form of various reports in the GUI. If the network design algorithms are
not able to provide a solution, then the user can modify the input data (for example, by relaxing some
user constraints) and run the analysis again.

1.3 Internal Architecture

To generate a network design, the SE enters the following parameters:

¢ The number of network sites
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1.3.1 Platform Support

e The type of equipment used at each site
e The distance separating the sites
e The type of fiber connecting the sites

¢ Service demands, including the service type, the protection type, and the number of channels
between nodes

Once the network parameters have been entered, the MetroPlanner finds the best routing, defines the
required add/drop filters, and places optical amplifiers and dispersion compensation units (DCUs) to fit
the user traffic demands at the minimum cost. Optimization is performed to meet the boundary
conditions. The optimization includes attenuation and amplification.

Finally, MetroPlanner 2.5 generates the BOM, which includes the product code, the quantity, and pricing
information. In addition, it creates other reports, such as a shelf-level view of the configuration, which
can be printed. This helps the SE understand how the shelf is built and helps to avoid confusion and
errors during the actual deployment. Within the BOM is the total network cost, which allows a quick
comparison of various design options.

1.3.1 Platform Support

MetroPlanner Release 2.5 supports the Cisco ONS 15454 DWDM optical platform.

1.3.2 Topology Support

MetroPlanner 2.5 supports the following network topologies:
¢ Bus (single span, point-to-point, and linear)
e Open (or hubbed) ring
e Closed (or meshed) ring

e Any to Any ring

1.3.3 Protection Scheme Support

MetroPlanner 2.5 designs support the following protection schemes:
¢ C(Client-based 1+1 protection
e Fiber switched protection
® Y-cable protection

e Unprotected

1.3.4 Service Support

MetroPlanner 2.5 can support any subset of the following services:
e 2R Any Rate
¢ Gigabit Ethernet
¢ 10GE—10 Gigabit Ethernet
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1.4 MetroPlanner Procedural Flow

ESCON—Enterprise System Connection
Fibre Channel

Fibre Channel 2G

Fibre Channel 10G

STM-1

STM-4

STM-16

STM-64

0C-3

0C-12

0C-48

0C-192

Sysplex CLO—Control Link Oscillator
Sysplex ETR—External Throughput Rate
D1 Video

SDI—Serial Data Input

FICON—Fiber Connection

FICON 2G

ISC-Peer (ISC-1 Peer Mode)
ISC-Compat (ISC-3 Compatibility Mode)
15530 2.5Gbps Aggregated

15530 10Gbps Aggregated

15530 MR Transport

15530 Data MXP

HDTV

D1 Video

DV-6000

The flowchart in Figure 1-1 on page 1-6 shows the following stages used to create a complete network
design:

1.

Place sites in the network. A site represents a potential location for placing equipment. This can be
accomplished by adding one site at a time or by using the Add Network tool to add multiple sites at

once.

Place fiber spans between the sites. A span represents a pair of fibers.

Specify service demands between sites as required. For Fixed adn P-Ring demands, only one line
will be drawn to represent all services between a particular service source and service destination

site.
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4. Analyze the network design.

5. In the event that the user would like to force automatic tool choices, there are options to adjust the
design and repeat the analysis until the desired configuration is achieved.

1.5 Planning Traffic in MetroPlanner 2.5

Traffic in MetroPlanner 2.5 is defined as an optical path for each pair of nodes requiring a service
demand. An optical path (connectivity) is defined as the sum of a wavelength between the two nodes.
This task is performed by creating a network design that minimizes the overall cost.

MetroPlanner 2.5 allows you to design flexible networks. A flexible network is a network that,
leveraging on the Reconfigurable OADM (ROADM) nodes, allows traffic modification/reconfiguration
as traffic requirements change. The main feature of flexible networks is the traffic
reconfiguration/modification among all the networked nodes or among a subset of them.

1.5.1 Basic Traffic Items

The following list gives definitions for some basic traffic items:

¢ Circuit—A single wavelength between a pair of source and destination nodes. In addition to the
source and destination nodes and all the attributes that are common to the demand containing the
circuit, it defines the following list of attributes:

Present/Forecast indication

Routing direction for unprotected service
ITU channel

Optical bypass indication

e Connectivity—An undefined number of channels than can vary from 0 to 32 between a pair of nodes.
The connectivity takes the meaningful parameter values of the circuit demand to which the
connectivity belongs.

e Demand—A set of services of the same type. It defines the set of parameters common to all the
circuits or connectivity that are part of this demand. The list of relevant attributes are:

Service Demand Label

Number of circuit in present
Number of circuit in forecast

Client Service Type

Protection Type

Optical bypass number of channels
Optical bypass site

Wave division multiplexing (WDM) Interface Type (TXT or ITU-LC choice)
WDM Card Type

Src Client Interface (SR, IR, or LR)
Dst Client Interface (SR, IR, or LR)
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I 1.5.2 Any-to-Any Traffic Demands

e Traffic Group: Groups all the demands between same set of nodes. The following traffic groups are
supported:

- ROADM—AIIl nodes in the subset can be connected. The way each node can be connected with
the others depends on the way you define the Traffic Type parameter. The number of channels
can vary from 0 to 32.

e Meshed—Each node defined in the set is connected to each other. This is the most common
traffic type.

e Hub—The user-defined hub node is connected to each of the other nodes defined in the
subset.

— P-Ring—Contains all the demands to support traffic topologies similar to bidirectional line
switch ring (BLSR) or multiplex section-shared protection ring (MS-SPRing). Each demand
that is part of the P-Ring is defined between a pair of nodes in the list of the added/dropped
nodes where BLSR-like (or MS-SPRing-like) traffic must be opened. The number of circuits is
the same for each demand, and must be user-specified (from 1 to 32).

— Fixed—Restricts the set of nodes at 2 sites. The number of circuits of each demand must be
user-specified (from 1 to 32).

1.5.2 Any-to-Any Traffic Demands

An any-to-any traffic demand is defined among a subset of nodes (minimum of two, maximum of every
node in the network). An any-to-any traffic demand allows each node belonging to the subset to establish
one or more circuits (an optical path carrying a service) with the other nodes. These circutis have the
same protection types and services to be carried. The actual connection capacity between each pair of
nodes belonging to the subset is dependant on the specific traffic pattern present in the overall network,
not just within the selected subset.

1.6 Viewing Traffic in MetroPlanner 2.5

MetroPlanner 2.5 represents all the user-defined traffic services as an explorer tree view within the
Traffic Tree window. Fixed, P-Ring, and ROADM traffic groups are shown on the tree view
(Figure 1-1).

Figure 1-1  Tree View

6 Metwark
Bl &® Site 1-8ite 2
E4* 10GE Client 1+1 [2/2]
B Connectivities
S Site 1-Site 2_1_1[P&F]
S Site 1-Site 2_1_2[P&F]
Bl &® Site 2-Site 3
E4* 10GE Y¥-Cahle [2/2]
B Connectivities
S Site 2-Site 3_1_1[P&F]
S Site 2-Site 3_1_2[P&F]
&® Site 3-Site 4
&® Site 4-Site 1
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Right-click an item to view a menu that allows you to view the optical results or the traffic matrix.
Right-clicking on the site name also allows you to edit the services. Refer to Chapter 2, “Designing
Networks with MetroPlanner” for more information about optical results, the traffic matrix, and editing
services.

Note  The tree view appears gray until you analyze the network. Refer to the “2.4 Analyzing the Network”
section on page 2-31. You cannot access the right-click menu until the network is analyzed.

1.6.1 Fixed Traffic Groups

Each fixed traffic group is represented by a folder labeled with a concatenation of the source and
destination site names. All the fixed services between these nodes are represented in this traffic group
(Figure 1-2).

Figure 1-2  Fixed Traffic Group

=L Site_x-Site_y
E-L Client ServieeType Protection Type [# Ch. Present / # Ch. Forecast] (Service Demand <n>)
=] Connectivity
|-Ser vieeCir cuit <1
|
|-ServiceCircuit <n>

115838

Each fixed demand defined between these nodes is represented by an item in this traffic group. The fixed
demand is labeled using the following information:

e Client Service Type
e Protection Type
e The number of present and forecast channels

The tree view shows a list of defined service circuits under each fixed demand. All the service circuits
are grouped in the Connectivities folder.

Each service circuit is labeled with a string containing the service circuit label and the Present/Forecast
(P&F) indication. The P represents circuits present since day 1, and the F represents circuits defined in
the forecast.

Note  For ROADM network topologies, fixed traffic can also include traffic demand with optical-bypass sites.
No additional patch cords are required for express or optical bypass channels in ROADM sites.

1.6.2 P-Ring Traffic Groups

Protected ring (P-ring) traffics groups are represented in the tree by a folder. This folder is labeled by
using a concatenation of the P-Ring substring and a progressive number automatically assigned by
MetroPlanner 2.5. Figure 1-3 shows an example of a P-ring traffic group.
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Note

Figure 1-3  P-Ring Traffic Group Example
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The list of add/drop sites (as defined in the P-Ring request) is shown in the P-Ring Traffic Group folder.
All the demands between each node pair are represented under this traffic group. Each demand
(generated by the P-Ring wizard) is labeled concatenating the following information:

e SiteA-SiteB (source and destination node labels for this demand)
e Client Service Type
e The number of present and forecast channels

Each service circuit is labeled as described in the “1.6.1 Fixed Traffic Groups” section on page 1-7.

For ROADM network topologies, P-ring traffic can also include traffic demand with optical-bypass sites.
No additional patch cords are required for express or optical bypass channels in ROADM sites.

1.6.3 ROADM Traffic Groups

Each ROADM traffic group is represented in the tree view by a folder labeled under the root traffic
network. All the sites and demands between each node pairs defined in the list (of added/dropped nodes)
are represented under this traffic group.

The ROADM traffic group folder contains the following information:

* One item for each site that is part of this ROADM group. You can only define one set of nodes for
each ROADM group.

e One folder for each defined ROADM demand. You can define more demands for the same ROADM
group for the same set of nodes.

Figure 1-4 shows an example of an ROADM traffic group.
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Figure -4 ROADM Traffic Group Example
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Each ROADM demand is defined by the ROADM demand name. The following set of parameters are
represented as an item of the ROADM demand in the tree view:

Traffic Type—Defines the supported traffic pattern type. The following options are supported:

— Meshed (Default)—A traffic pattern where a connectivity is defined for each node pair in the
traffic group

— Hub (Hub Node)—Defines connectivity between the defined hub node and every other node in
the traffic group. You must specify the selected hub node among the list in the group.

Routing Strategy—defines the maximum number of allowed connectivities, and the way the
connectivities are routed by MetroPlanner 2.5. The following options are supported:

— Protected (Default)—Each node pair in the traffic group is connected using two connectivities.

— Unprotected Optimum Optical Path—Each node pair is connected using one connectivity. The
Unprotected Optimum Optical Path minimizes the number of required optical amplifiers, but
also restricts the number of channels that can be deployed among the nodes of the traffic group
(maximum of 32 channels between each node pair) in the installed network.

— Unprotected Minimum Hop Count—Each node pair in the traffic group is connected by one
connectivity. The unprotected minimum hop count maximizes the number of channels (for
unprotected traffic types only) that can be deployed among the nodes of the traffic group, but
can requires a higher number of optical amplifiers on the unprotected optimum optical path
(maximum of 32 channels between each node pair) in the installed network.

— Unprotected Subnet—Each node pair in the traffic group is connected using one connectivity.
You can manually force connectivities on only one branch of the ring. For unprotected subnets,
you must manually select one starting node of the branch and the direction the ring must be
traversed to define the subnet, starting from the initial site. Branch direction is specified
defining the outgoing side referred to the starting node.This routing strategy option allows you
to exclude some critical paths and (with ROADM traffic groups containing 2 sites) to force each
ROADM connectivity clockwise or counterclockwise.

List of selected Client Service Types—The list of client service types to be supported for this
demand is represent by a set of item under the related ROADM Demand folder. You can
simultaneously request more then one Client Service Type for each demand (Any Client).

List of selected DWDM Card Interfaces—Represents the list of DWDM card interfaces you selected
to support the list of selected Client Service Types. You can simultaneously request more than one
DWDM card interface for each demand and for each client service type. Each DWDM card interface
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is characterized by a set of optical performances. Each DWDM card interface is labeled by
concatenating the selected DWDM card type and the protection type information. A tooltip on each
DWDM card interface item shows which client service types are supported by this interface.

To avoid duplication in the tree view while using the Protected routing strategy:

e DWDM card interfaces with client 1+1 and Y-cable protection types are represented by only one
DWDM card interface item. The selected protection types are listed in brackets, separated by
commas.

e DWDM card interfaces with fiber-switched protection types are represented by a separate DWDM
card interface item.
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Designing Networks with MetroPlanner

Cisco MetroPlanner provides you numerous tools for customizing the software, creating and analyzing
networks, and creating a bill of materials. You can use to MetroPlanner perform the following tasks:

e 2.1 Launching MetroPlanner and Updating the Pricing File, page 2-1
e 2.2 Setting MetroPlanner Options, page 2-4

e 2.3 Creating Networks, page 2-13

e 2.4 Analyzing the Network, page 2-31

e 2.5 Editing and Viewing Network Components, page 2-39

e 2.6 Saving and Loading Network Designs, page 2-58

e 2.7 Completing the Network Design, page 2-58

e 2.8 Ordering the Equipment, page 2-64

e 2.9 Generating a BOM, page 2-65

N

Note To run MetroPlanner, you must install the Java 2 Platform, Standard Edition (J2SE), v 1.4.2_04 Java
Runtime Environment (JRE). You can download it from the following URL:

http://java.sun.com/j2se/1.4.2/download.html

2.1 Launching MetroPlanner and Updating the Pricing File

When MetroPlanner Release 2.5 is first launched, you will have the option of downloading an updated
pricing file from CCO.

Step1  Launch MetroPlanner by double-clicking the MetroPlanner R2.5 icon. The Price Update Option window
appears (Figure 2-1).
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Figure 2-1  Price Update Option

Price Update Option ___
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[EC00RRe ]| LocaFieUpdatz | Caniine |

Step2  To obtain a new price list from CCO, click CCO Update. You will be asked for your CCO login and

password before the new price list is downloaded.

To use a pricing file that is already located on your workstation, click Local File Update. You will then
be able to browse your workstation for the pricing file. The file format of the pricing file are separated
by pipes. Each part has the following fields:

List ID (Not used by MetroPlanner)
Product Family or Major Parent

Minor Parent (Not used by MetroPlanner)
Product Number or Product ID

Product Description

Service Category

Unit Price ($USD)

Major ID (Not used by MetroPlanner)
Minor ID (Not used by MetroPlanner

Step3  To open MetroPlanner without updating, click Continue. The MetroPlanner Activation window opens
(Figure 2-2).
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2.1 Launching MetroPlanner and Updating the Pricing File

Figure 2-2 MetroPlanner Activation Window
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Step4  Enter your user name in the Login field.
Step5  Enter your password in the Password field.

Step6  Click Remember login and password if you want MetroPlanner to save your user login name and
password.

Step7  Click OK. The Tip of the Day window opens (Figure 2-3).

Figure 2-3  Tip of the Day Window

ul Tip of the Day .
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The Tip of the Day window displays important tips about MetroPlanner features.
Step8  Click Previous Tip or Next Tip to see either the previous or next tip in the tip sequence.
Step9  Click Close Tip to close the window.

Step10  If you want the Tip of the Day window to display each time you open MetroPlanner, select Show “Tip
of the Day” At Startup. Deselecting this option causes the window to remain closed when you open
MetroPlanner.

You can open the Tip of the Day window at any time from MetroPlanner by selecting Help > Tip of the
day in the menu bar.

2.2 Setting MetroPlanner Options

MetroPlanner provides numerous options for customizing the tool and the designs. You can set the
options for individual projects, you can create defaults for all projects, and you can set general options
for the MetroPlanner tool.

2.2.1 Setting Project Options

Setting the options for individual projects allows you to adjust the layout, BOM options, and other
project-related options. You can only set project options when the network is in Design mode.

Step1  Choose Options > Project Options. The Project Options window appears.
Step2  Click Analyzer Algorithm. The Analyzer Algorithm section comes into focus (Figure 2-4).

Figure 2-4  Project Options Window—Analyzer Algorithm
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Step 3

Note

Step 4

Step 5

Step 6

2.2.1 Setting Project Options ||

Select the analyzer algorithm type.

MetroPlanner distinguishes between two classes of applications: Metro Core, where the channel power
is equalized and dispersion compensation is applied; and Metro Access, where the channels are not
equalized and dispersion compensation is not applied. MetroPlanner offers 8, 16, and 32 channel Metro
Core algorithm types.

Placing an upper limit on the maximum number of allowed wavelengths in the design allows
MetroPlanner to provide better optical performances.

Use Metro Access for small networks. Small networks have a low number of sites (approximately three
to five nodes) and short spans.

The Metro Access algorithm applicability is restricted by:

¢ The maximum number of required amplifiers for each path direction and for each subnetwork
(maximum 5)

e Lack of Dispersion Compensation Unit (DCU) compensation requirement

e The overall network circumference (45 km [28.0 miles] if there is at least one 10-Gbps service
circuit, and 120 km [74.5 miles] if there are only 2.5-Gbps service circuits)

Select No In-line Bulk Attenuator Design to design the network without using any in-line bulk
attenuators. If the network cannot be designed without using external in-line attenuators, MetroPlanner
displays the following error message: "Unfeasible Network design. Site X should require usage of in-line
attenuator".

Select No TXT/Line-Card Bulk Attenuator Design to design the network without using any external Rx
bulk attenuators on transponder or line cards. If any of the clients require Rx bulk attenuators, the related
channel is shown with anomalous working condition (red, orange or yellow), and no Rx bulk attenuators
are shown in any of the reports or BOMs.

Click BOM Options. The BOM Options section comes into focus (Figure 2-5).

Figure 2-5 Project Options—BOM Options
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Step 7

Step 8

Step 9

Select the following options, as required:

Include SW License(s)—BOM includes one software license for each shelf for every site in the
network. Only shelves containing cards that are carrying present traffic are included.

Include Paper Documentation—BOM includes one hardcopy documentation item for each site in the
network. Pass-through sites are not included.

Include CD Documentation—BOM includes one documentation CD item for each site in the
network. Pass-through sites are not included.

Include Optical patch-cord to/from TXT/Line Card—The BOM includes both:

— All patch cords connecting the transponder and the line card with the optical add/drop
multiplexing (OADM) and multiplexing/demultiplexing filters

— All patch cords connecting the transponder with the Y-cable flex-layer modules

Only the patch cord connecting the transponder and line card for present traffic are included on the
BOM. The patch cord for connecting TXT cards and line card can be of different types and lengths.

Network Bulk Attenuator (for TXT/Line Card)—The BOM includes all the receive bulk attenuators
(based on the results in the Optical Channel Results tab) and the in-line bulk attenuator. Only the
receive bulk attenuators that refer to the present traffic are included in BOM.

Bulk attenuators are also used in the following cases:

— In-line attenuation for sites without any added or dropped channels in one side, where
attenuation is required to equalize the channels

— Line amplifier sites where both preamplifier and booster cards require 10 dB of attenuation
between the preamplifier and the booster amplifier.

These bulk attenuators are always in the BOM, regardless of the TXT/Line Card Bulk Attenuator
selection.

Hide BoM Prices—Hides the dollar values of the items on the BOM.

Enter the global discount percentage in the Global Discount field. MetroPlanner applies this percentage
to all networks.

Click Layout. The Layout section comes into focus (Figure 2-6).

Figure 2-6 Project Options—Layout
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Step 10

Step 11

Step 12

Step 13

Step 14

Step 15

2.2.1 Setting Project Options ||

Select either American National Standards Institute (ANSI) or European Telecommunications Standards
Institute (ETSI) in the Network Platform Layout drop-down list.

Check TXT/Line Card placement OSMINE compliant to place the TXT/line card in the shelf, with
the following constraints:

e Each unprotected transponder or line card facing west can only be placed on the left side of the shelf
(Slots 1 to 6), and each unprotected transponder or line card facing east can only be placed on the
right side of the shelf (Slots 12 to 17).

e Each pair of transponders or line cards that is involved in a Client 1+1 or Y-cable protection group
must be placed in adjacent slots.

¢ FEach transponder involved in fiber-switched protection can be placed on the left or right side of the
shelf in order to fill the empty slots.

Leave TXT/Line Card placement OSMINE compliant unchecked to place the TXT/line card in the
shelf with the following constraints:

e The transponder and line card facing west-side traffic must be placed in the left shelf section
(Slots 1 to 6), and the transponder and line card facing the east side traffic must be placed in the right
shelf section (Slots 12 to 17).

e If the number of west and east added and dropped channels changes, the remaining client
transponder/line cards are placed to fill the remaining available slots.

e When using Y-cable protection, the two transponders must be placed in the same shelf.
e When using Client 1+1 protection, MetroPlanner places the two client cards in the same shelf.

Click General Options. The General Options section comes into focus (Figure 2-7).

Figure 2-7 Project Options— General Options
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In the Site MTTR field, enter the mean time to repair (MTTR) for each site in the network. If you change
the MTTR value after creating sites, the new value will only apply to sites you create after the change.

Select whether the OSNR values in the Result tables are reported using 0.1-nm resolution bandwidth
(RBW) or 0.5-nm RBW in the Resolution Bandwidth RBW field. The default value is 0.5 nm.

Choose either kilometers (km) or miles as the default span length unit of measure in the Show spans
length in field.
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Step16 Click OK when finished.

2.2.2 Setting Default Project Options

Setting the default options for all new projects allows you to adjust the layout, BOM settings, and other
project-related options. These options will be the default settings for each new project.

Step1  Select Options > Default Project Options. The Default Project Options window appears. The Default
Project Options window is nearly identical to the Project Options window, with the addition of the
Span Parameters option in the left panel.

Step2  Complete the steps in the “2.2.1 Setting Project Options” section on page 2-4.

Step3  Click Span Parameters. The Span Parameters area comes into focus (Figure 2-8).

Figure 2-8 Default Project Options—Span Parameters
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The Span Parameters area displays the same information as the Fibres Dialog window (Figure 2-20 on
page 2-22).

Step4  Complete Step 5 through Step 14 in the “2.3.2.2 Adding Fiber Spans” section on page 2-22.

Step5  Click OK. These settings are now the default settings for all new projects.
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2.2.3 Setting General Options

Setting the general options allows you to change the way MetroPlanner displays information.

Step1  Choose Options > General Options from the menu. The General Options window appears.

Step2  Select Layers and Tags. The Layers and Tags section comes into focus (Figure 2-9).

Figure 2-9 General Options—Layers and Tags
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Step3  In the Fibers area, select one or more check box depending on whether or not you want MetroPlanner to
display the fibers, the span loss, and the span.

Step4  In the Sites area, select one or more check box depending on whether or not you want MetroPlanner to
display the names, the amplifiers (amps), and the forced amps of the sites in the network design.

Step5  In the Channels area, select one or more check box depending on whether or not you want MetroPlanner
to display the Fixed/BLSR and ROADM channels in the network design.

Step6  Click Colors and Styles. The Colors and Styles section comes into focus (Figure 2-10).
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Figure 2-10 General Options—Colors and Styles
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Step 7

a Color window appears (Figure 2-11).

Figure 2-11 Pick a Color Window
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Select the color for the items in the window by clicking the rectangles to the right of the text. The Pick

[l Cisco MetroPlanner DWDM Operations Guide, Release 2.5

October 2004 |



| Chapter2 Designing Networks with MetroPlanner

Step 8
Step 9
Step 10

Step 11

Step 12
Step 13

Step 14

Step 15

2.2.4 Customizing the Design Background

Use the Swatches, HSB, or RGB tab to select a new color for the item.
Click OK to keep the new color, or click Reset to restore the default color.

To change the line style for fibers, selected fibers, channels, selected channels, and ROADM channels,
select a new style from the drop-down list in the Style column.

To change the line width for fibers, selected fibers, channels, selected channels, and ROADM channels,
select a new width from the drop-down list in the Size column.

To discard all the changes, click Restore Defaults at the bottom of the graphic.

Select Look and Feel. The Look and Feel section comes into focus (Figure 2-12).

Figure 2-12 General Options—Look and Feel
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Select appearance for the MetroPlanner application. In order to see the new appearance, you must restart
the application. The Windows (system) selection displays the application in your current Windows
session.

Click OK to keep the changes and close the window.

2.2.4 Customizing the Design Background

Step 1

You can customize your MetroPlanner window background with a graphic image to enhance the
presentation of your network design.

Choose Options > Background Map from the menu. The Choose Background Map window appears
(Figure 2-13), allowing you to select a file in JPG or GIF format.
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Figure 2-13 Choose Background Map Window
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Step2  Select a map from the list on the left, or click Import to add a new map to the list.

Step3  Click OK. The file will appear as a background for any new network, or for the network you currently
have open (Figure 2-14).
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Figure 2-14 Map File Background
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| Design

Step4  If the network map does not appear, choose Options > Show Map from the menu.

2.3 Creating Networks

In MetroPlanner, network design components consist of sites, spans, and service demands. Components
can be added to a network design by selecting the buttons shown in Table 2-1.

Table 2-1 Menu Buttons for Adding Network Design Components

Button Description

& Network Wizard

@ Add Site

8z Add Fibre

8q Add Channel/Service
y Edit Mode
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2.3.1 Adding Networks Using the Network Wizard

Note

Step 1

Step 2
Step 3
Step 4

Step 5

Step 6

Use the Network Wizard button to add a ring or linear dense wavelength division multiplexing (DWDM)
network to the network design. The Network Wizard button allows you to add several sites to the network
design in one step.

The Network Wizard feature adds a ring or linear DWDM network with a maximum of 16 active sites.

Click Network Wizard on the menu bar. The Network Wizard window appears (Figure 2-15).

Figure 2-15 Network Wizard (Step 1) Window
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Enter a name for the designed network in the Design Version field (128 maximum characters).
Enter a description of the designed network in the Design Description field (256 maximum characters).

Enter the name of the customer requiring this network design in the Customer Name field (128 maximum
characters).

Enter the name of the person who designed the network in the Prepared By field (128 maximum
characters).

Click Next. The second panel of the Network Wizard appears (Figure 2-16).
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Step 7

Step 8
Step 9

Step 10

Step 11

2.3.1 Adding Networks Using the Network Wizard

Figure 2-16 Network Wizard (Step 2) Window

Network Wizard - Step 2 of 3 x|
~Hetwork

Mumber of Nodes 3
Topology Ring -

Metwork Platform Layout ARSI -

Span Measurement Units Km -

Back || Next Finish Cancel

115206

Enter the number of desired nodes in the network in the Number Of Nodes field. The maximum allowed
value is 60.

~

Note  The maximum number of non-passthrough ONS 15454 Multi-Service Transport Platform
(MSTP) nodes is 16.

Select a topology from the Topology drop-down list. You can choose either a ring or a linear topology.

Select a network platform layout from the Network Platform Layout drop-down list. You can choose
either ANSI (the North American standard) or ETSI (the international standard). ANSI networks will
not allow you to define SDH (ETSI) service demands. ETSI networks will not allow you to define
SONET (ANSI) service demands.

~

Note  After the layout is set for a network, you cannot change the individual sites.

Select the unit of measure that MetroPlanner will use to specify the span length in each span in the
Span Measurement Units drop-down list. The span units can be either kilometers (km) or miles.

Click Next. The third panel of the Network Wizard appears (Figure 2-17).
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Step 12

Step 13

Step 14

Step 15

Step 16

Step 17
Step 18
Step 19

Figure 2-17 Network Wizard (Step 3) Window
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Enter the substring text that defines the span labels in the Spans Label Tag field. MetroPlanner defines
all subsequent spans by adding a sequential number to the label in the Spans Label Tag field (for
example, Span 1).

Select a fiber type from the Span Fibre Type drop-down list. The MetroPlanner Analyzer performs a
check to make sure that the network contains spans with fiber types that the design algorithm can manage
on the same network. If this condition is not met, the analyzer stops analyzing the network and creates
an error. The available fiber types are:

¢ G652-SMF-Supported for both Metro Core and Metro Access
e E-LEAF-Supported for Metro Core only
e  TW-RS-Supported for Metro Core only

Enter a span length in the Span Length field. The displayed unit of measure is retrieved from the
Span Measurements Units field.

Enter the end of life (EOL) aging factor in the Ageing Factor field. This factor is multiplied by the start
of life (SOL) total span loss without connectors.

Enter the EOL aging loss in the Ageing Loss field. The EOL loss per span value is added at the end of
life to each discrete fiber in the network (for example, to add an EOL margin for splicing).

Enter the concentrated loss at the east end of the span in the Connector Loss East field.
Enter the concentrated loss at the west end of the span in the Connector Loss West field.

Choose either the Length Based Model or the Absolute Model radio button.

Cisco MetroPlanner DWDM Operations Guide, Release 2.5
m. October 2004 |



| Chapter2 Designing Networks with MetroPlanner

Step 20

Step 21

Step 22

2.3.1 Adding Networks Using the Network Wizard

If you choose Length Based Model in Step 19, enter values in value fields for the following properties
listed in the table at the bottom of the window:

Loss Factor—The value of the SOL fiber loss per kilometer used to calculate the loss of each span
in the network. The fiber loss factor is always entered in dB/km, even if you selected miles as the
span measurement unit. MetroPlanner automatically converts the loss factor from miles to
kilometers.

Chromatic Dispersion factor—The fiber chromatic dispersion factor. The default value is dependent
on the selected fiber type. Any value you enter is lost whenever you change the fiber type. Chromatic
dispersion is always entered in ps/nm/km, even if you selected miles as the span measurement unit.
MetroPlanner automatically converts the loss factor from miles to kilometers. Fiber chromatic
dispersion is defined for the middle of the wavelength band. It is defined at approximately 1545.3
nm.

PMD factor—The polarization mode dispersion (PMD) factor. The default value is dependent on the
selected fiber type. Any value you enter is lost whenever you change the fiber type. PMD is always
entered in  ps/{+fkm), even if you selected miles as the s pan measurement unit. MetroPlanner
automatically converts the loss factor from miles to kilometers.

Total SOL Loss w/o Connectors—The start of life link fiber loss for each span, without the
connector concentrated loss. The total SOL loss without connectors is equal to the loss factor
multiplied by the length. In the Length Based model, this value is calculated automatically.

Total SOL Loss—The start of life link fiber loss for each span with the connector concentrated loss
contributions. The total SOL loss is equal to the total SOL loss without connectors added to the
connector loss west and connector loss east. In the Length Based model, this value is calculated
automatically.

Total EOL Loss—The end of life link fiber loss for each span. In the Length Based model, this value
is calculated automatically.

Total Chromatic Dispersion—The overall link fiber chromatic dispersion for each span. In the
Length Based model, this value is calculated automatically.

Total PMD (DGD)—The differential group delay (DGD) is the difference in arrival times of the two
polarization modes at a particular wavelength and time with a specific PMD coefficient. In the
Length Based model, this value is calculated automatically.

If you chose Absolute Model in Step 19, enter values in value fields for the following properties listed
in the table at the bottom of the window:

Total SOL Loss w/o Connectors—The start of life link fiber loss for each span, without the
connector concentrated loss. The total SOL loss without connectors is equal to the loss factor
multiplied by the length.

Click Finish. MetroPlanner performs a check for fiber factor valid values. If the fiber factor values are
within the valid range (refer to Table 2-2 on page 2-19), MetroPlanner creates a visual representation of
the network (Figure 2-18 on page 2-18). If the values are out of range, MetroPlanner issues a warning,
asking you to confirm the input values.
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Figure 2-18 Initial Network View
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Table 2-2 Valid Ranges for Fiber Coefficient Values

2.3.2 Adding Networks Manually W

Min Max
Min Error Warning Default Warning Max Error
Parameter Value Value Value Value Value
G..652-SMF Loss factor 0 0.2 (%) 04 10
dB/km dB/km dB/km dB/km dB/km
Chromatic 0 16.2 16.7 17.1 30
Dispersion factor ps/nm/km | ps/nm/km |ps/nm/km | ps/nm/km | PS/nm/km
@ 1545.3 nm
PMD factor 0 0.0 0.1 0.5 10
psfifkrmy | psfikm) | psfikm) | ped(km) pa(krm)
G.655-E-LEAF |Loss factor 0 0.2 (*) 0.4 10
dB/km dB/km dB/km dB/km dB/km
Chromatic 0 3.4 3.80 4.2 10
Dispersion factor ps/nm/km | ps/nm/km |ps/nm/km |ps/nm/km | PS/nm/km
@ 1545.3 nm
PMD factor 0 0 0.1 0.5 10
psfifkrmy | psfikm) | psfikm) | ped(km) pa(krm)
G.655-TW-RS |Loss factor 0 0.2 (%) 0.4 10
dB/km dB/km dB/km dB/km dB/km
Chromatic 0 3.8 4.19 4.6 10
Dispersion factor ps/nm/km | ps/nm/km |ps/nm/km |ps/nm/km | PS/nm/km
@ 1545.3 nm
PMD factor 0 0 0.1 0.5 10
psfifkrmy | psfikm) | psfikm) | ped(km) pa(krm)

2.3.2 Adding Networks Manually

You can manually add network design elements using the following network design functions: adding
sites, adding spans, and adding services.

23.2.1 Adding Sites

Use the Site Dialog window to place an empty site in the network design. You can also use the

Site Dialog window to build a network manually, bypassing the Network Wizard, or to add new sites to
an existing design. A site is a customer premises location where any equipment can be collocated in a
rack within a building.
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Note  MetroPlanner supports up to 60 sites. However, the ONS 15454 DWDM platform will only support up
to 16 non-passthrough sites on any given network. Although MetroPlanner will allow you to add more
than 16 sites, it will generate errors when the network analysis runs.

Note  MetroPlanner R2.5 only supports two fiber spans per site (east and west).

Step 1 Click Add Site Mode on the menu bar. Alternatively, you can right-click in the main window and select
Add New Default Site or Add New Site from the shortcut menu. The cursor then changes to a hand
holding a blue circle.

Step2  Double-click the MetroPlanner window at the point where you want to place the new site. The
Site Dialog window appears (Figure 2-19).

Figure 2-19 Site Dialog Window

il Site Dialog x|

~ME Site Parameters E?,. ¢

Site Mame i i

Bite 4| | site s -
Site IP Address (Opt) [265 245 255 4 ;
Site MTTR (hours) 20
Maint. Centre Mame -

- .

Shelf Layout

~NE Site Type

Configuration Auto -
Equipment

Hyhrid Mode Config |

~NE Site Amplifier
Preamplifier West Side | 4 T0 »
Eooster West Side ALUTO w»

Preamplifier East Side | a1 70 »

Eooster East Side ALUTO w»

i EIEIEE

OK | | Cancel

115543

Step3  Enter the name of the site in the Site Name field.
Step4  Enter the site IP address (if desired) in the Site [P Address field.
Step5  Enter the site MTTR hours in the Site MTTR field.
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Step6  Select the maintenance center that will support this site in the Maint. Centre Name field. If there are no
listed maintenance centers, create one using the steps in the “2.9.6 Establishing Maintenance Centers”
section on page 2-71.

Step7  Select an ANSI or ETSI shelf layout in the Shelf Layout field.

Step8  Select a network element (NE) site type in the Configuration field. The choices are:

e Auto—The site type is determined based on the network analysis.

e Hub—The site is a hub site.

e Terminal—The site is a full (32 channel) terminal site.

¢ ROADM—The site is an ROADM site with a single- or double-slot 32 DMX demultiplexer.

e OADM Full—The site is a full OADM site.

e OADM Active—The site is an active (amplified) OADM site.

e OADM Passive—The site is a passive (non-amplified) OADM site.
Hub, terminal, and ROADM sites support the equipment listed in Table 2-3. OADM Full Configuration
sites are always implemented using 32 MUX-O and 32 DMX-O cards.
Table 2-3  Site Equipment
Site Configuration Supported Equipment
Hub Auto (default)

32MUX-0/32DMX-0

32 WSS/32 DMX

32 WSS/32 DMX-O
Terminal Auto (default)

32MUX-0/32DMX-0

32 WSS/32 DMX

32 WSS/32 DMX-O
ROADM 32 WSS/32 DMX (default)

32 WSS/32 DMX-O

Step9  Select the set of cards required for the selected configuration from the list in the Equipment field.
Available choices are Auto, 32 Channel Mux/Demux, 32WSS/32DMX, and 32WSS/32DMX-O.

Step 10  If this site is part of a hybrid node configuration, check the Hybrid Node Config check box. Hybrid node
configuration is only available if you select Auto, OADM Active, OADM Passive, Line Amplifier, or
Terminal.

Step 11 In the Preamplifier West Side field, select whether to place a preamplifier on the west side of the node.
If you select Auto, MetroPlanner decides whether to place the item automatically. This option is not
available if you selected OADM Passive as the site type.

Step12 In the Booster West Side field, select whether to place a booster amplifier on the west side of the node.
If you select Auto, MetroPlanner decides whether to place the item automatically. This option is not
available if you selected OADM Passive as the site type.

Step 13  In the Preamplifier East Side field, select whether to place a preamplifier on the east side of the node. If
you select Auto, MetroPlanner decides whether to place the item automatically. This option is not
available if you selected OADM Passive as the site type.
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Step 14

Step 15

Step 16

In the Booster East Side field, select whether to place a booster amplifier on the east side of the node. If
you select Auto, MetroPlanner decides whether to place the item automatically. This option is not
available if you selected OADM Passive as the site type.

Click OK to place the site, or Cancel to quit. The site appears as a blue icon, with the site name appearing
below it.

To edit the site, click Edit Mode on the menu bar, then double-click the site you want to edit. The
Site Dialog window (Figure 2-19) appears, allowing you to make changes to the site.

2.3.2.2 Adding Fiber Spans

Step 1

Step 2

Step 3

Step 4

Step 5

After adding the sites, use the Add Fibre Mode feature to draw the fiber spans between sites. A fiber span
consists of a pair of fibers (one transmit and one receive) between two sites.

Click Add Fibre Mode on the menu bar. The cursor changes to a pencil with a series of numbers beside
it.

Click one of the sites you want to connect with a fiber span. This site will be the source site for later
network analysis output.

Move the cursor to the other site. When you move the cursor, a line appears between the two sites. This
site will be the destination site for later network analysis output.

Click the destination site. The Fibres Dialog window appears (Figure 2-20).

Figure 2-20 Fibres Dialog Window
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Enter the name of the span displayed on the network design in the Span Label field. MetroPlanner
automatically generates a default span name, starting with “Span 17, and numbering sequetially. A
second span would have the default name of “Span 2”.
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Step 6
Step 7
Step 8
Step 9

Step 10
Step 11
Step 12
Step 13

Step 14

Step 15

2.3.2 Adding Networks Manually W

Select the fiber type from the Span Fibre Type drop-down list.

Enter the length of the span, in kilometers, in the Span Length field.

Enter the EOL aging factor in the Ageing Factor field.

Enter the EOL aging loss in the Ageing Loss field. The EOL loss per span value is added at the EOL to
each discrete fiber in the network.

Enter the concentrated loss at the east end of the span in the Connector Loss East field.

Enter the concentrated loss at the west end of the span in the Connector Loss West field.

Choose either the Length Based Model or the Absolute Model radio button.

If you choose Length Based Model in Step 12, enter values in value fields for the following properties
listed in the table at the bottom of the window:

Loss Factor—The value of the start of life fiber loss per kilometer used to calculate the loss of each
span in the network. The fiber loss factor is always entered in dB/km, even if you selected miles as
the span measurement unit. MetroPlanner automatically converts the loss factor from miles to
kilometers.

Chromatic Dispersion factor—The fiber chromatic dispersion factor. The default value is dependent
on the selected fiber type. Any value you enter is lost whenever you change the fiber type. Chromatic
dispersion is always entered in ps/nm/km, even if you selected miles as the span measurement unit.
MetroPlanner automatically converts the loss factor from miles to kilometers. Fiber chromatic
dispersion is defined for the middle of the wavelength band. It is defined at approximately

1545.3 nm.

PMD factor—The PMD factor. The default value is dependent on the selected fiber type. Any value
you enter is lost whenever you change the fiber type. PMD is always entered in  ps/{+km), even if
you selected miles as the span measurement unit. MetroPlanner automatically converts the loss
factor from miles to kilometers.

Total SOL Loss w/o Connectors—The start of life link fiber loss for each span, without the
connector concentrated loss. The total SOL loss without connectors is equal to the loss factor
multiplied by the length. This field is read-only.

Total SOL Loss—The start of life link fiber loss for each span with the connector concentrated loss
contributions. The total SOL loss is equal to the total SOL loss without connectors added to the
connector loss west and connector loss east. This field is read-only.

Total EOL Loss—The end of life link fiber loss for each span. This field is read-only.

Total Chromatic Dispersion—The overall link fiber chromatic dispersion for each span. This field
is read-only.

Total PMD (DGD)—The DGD is the difference in arrival times of the two polarization modes at a
particular wavelength and time with a specific PMD coefficient. This field is read-only.

If you chose Absolute Model in Step 13, enter values in value fields for the following properties listed
in the table at the bottom of the window:

Total SOL Loss w/o Connectors—The start of life link fiber loss for each span, without the
connector concentrated loss. The total SOL loss without connectors is equal to the loss factor
multiplied by the length.

Click OK to place the span. The span length appears between the selected sites (Figure 2-21).

[ october 2004

Cisco MetroPlanner DWDM Operations Guide, Release 25 g



Chapter2  Designing Networks with MetroPlanner |

M 232 Adding Networks Manually

Figure 2-21 Sample Span Length Between Two Sites
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2.3.2.3 Adding Services

Adding services between sites allows you to specify the fixed service requests that are needed between
two sites.

Step1  Click Add Channel Mode on the menu bar. The cursor changes to a pencil with arrows pointing in
opposite directions beside it.

Step2  Click and release on one of the sites to which you want to add a channel.
Step3  Move the cursor to the other site. When you move the cursor, a line appears between the two sites.

Step4  Click the destination site. The Service Demand Dialog window appears (Figure 2-22).

Cisco MetroPlanner DWDM Operations Guide, Release 2.5
m. October 2004 |



| Chapter2 Designing Networks with MetroPlanner

Step 5
Step 6

Step 7

Step 8

2.3.2 Adding Networks Manually W

Figure 2-22 Service Demand Dialog Window
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Enter a label for identifying the service in the Service Label field.

In the Present Demand area, enter the present number of demand channels required in the
Num of Channels field.

In the Forecast Demand area, enter the total number of channels that will be needed in the future in the
Num of Channels field. The value should be the number of channels needed on day one plus the number
of channels the network will need to accommodate future growth.

Select a Client Service Type for the channel. The choices are:

0C-3/12/48/192 (ANSI)

STM-1/4/16/64 (ETSI)

Gigabit Ethernet

10GE—10 Gigabit Ethernet

Fibre Channel

Fibre Channel 2G

Fibre Channel 10G

1G FICON (1 Gigabit Ethernet-FICON)

2G FICON (2 Gigabit Ethernet-FICON)
ISC-Compat (ISC-1)

ISC-Peer (ISC-3)

Sysplex ETR (Sysplex External Time Reference)
Sysplex CLO (Sysplex Control Link Oscillator)
ESCON—Enterprise System Connection
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e DI Video

e SDI—Serial digital interface

e HDTV—High-definition television
e DV-6000

¢ 2R Any Rate

e 15530 10-Gbps Aggregate

e 15530 2.5-Gbps Aggregate

e 15530 MR Transport

e 15530 Data MXP

Step9  Select a protection type from the Protection Type field. The four protection types are Client 1+1,
Fiber Switched, Unprotected, and Y-Cable.

Step 10  In the Optical Bypass area, enter the number of channels for the optical bypass in the Num. of Ch. field.
The number of optical bypass channels must be less than the number of channels listed in the
Present Demand area.

Step 11 Select an optical bypass site name from the Site Name drop-down list.

Step12 Choose a DWDM interface type. The two choices are Transponder and Line Card.
Step13  Select a DWDM Card Type from the drop-down list.

Step14  Select a Client Interface Source from the drop-down list.

Step15  Select a Client Interface Destination from the drop-down list.

Step16  Click OK to place the channel, or Cancel to quit. If you click OK, a line representing the channel appears
between the two sites (Figure 2-23). The line has a number above it that indicates the number of channels
present.

Figure 2-23 Sample Channel Between Two Sites
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2.3.3 Creating an ROADM Traffic Group

MetroPlanner allows you to create ROADM traffic groups for a defined list of nodes.

Step1  Right-click the Network folder in the traffic view. A menu appears.
Step2  Select Add ROADM Group from the menu. The ROADM Group window appears (Figure 2-24).
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Figure 2-24 ROADM Group Window
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Step3  Enter a name for the group in the Group Name field.

Step4  Click the check boxes beside the nodes you want to include in the ROADM group. Only Auto, ROADM,
and Terminal sites are available. Refer to the “2.3.2.1 Adding Sites” section on page 2-19 for more
information.

Step5  Click All to add all the sites to the group.
Step6  Click None to remove all the sites from the group.

Step7  Click OK to create the group, or Cancel to close the window without creating the group.

2.3.4 Creating an ROADM Demand

MetroPlanner allows you to manually create ROADM demands for the selected ROADM traffic group.

Step 1 Right-click on an ROADM traffic group. A menu appears.
Step2  Select Add Demand > Roadm from the menu. The Demand Dialog window appears (Figure 2-25).
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Step 3
Step 4

Step 5
Step 6

Step 7

Step 8
Step 9

Step 10

Figure 2-25 Demand Dialog Window
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Enter a name for the demand in the Demand Name field.

Select a traffic type from the drop-down list. If you select Hub, the First Site drop-down button becomes
available. If you selected Meshed, skip to Step 6.

For Hub traffic types, select the originating site from the First Site drop-down list.

Select a connectivity type from the Connectivity drop-down list. The connectivity choices are Protected,
Unprotected Minimum Hop, Unprotected Optimum Path, and Unprotected Subnet. Refer to the

“1.6.3 ROADM Traffic Groups” section on page 1-8 for more information on the connectivity choices.
If you select Unprotected Subnet, the two drop-down buttons to the right of the Connectivity drop-down
button become available. Skip to Step 8 if you selected any other connectivity type.

Select the subnet starting node and outgoing side from the two drop-down buttons beside the
Connectivity drop-down button.

Check the boxes for one or more service types for the ROADM demand from the list in the left panel.

You can further refine your choices in the right panel by adding client interfaces, and by choosing
protection types. You can select more than one client interface to support the same service type. All the
client interfaces supporting each selected service type are shown in the right panel. Client interfaces that
only support unrequired service types are unavailable. MetroPlanner, by default, checks the best client
interface to support each service. The protection check boxes allow you to define the type of protection
that is supported for the selected client interface. These check boxes are only available when:

e The selected connectivity type is Protected
¢ The client interface is not Fiber Switched
¢ The Yes/No check box is checked

Click OK to create the demand, or Cancel to close the window without saving any changes.
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2.3.5 Creating a Protected Ring Network

MetroPlanner allows you to create protected ring networks.

Step 1 Create a ring network using either the procedures in the “2.3.1 Adding Networks Using the Network
Wizard” section on page 2-14 or by manually placing sites into a ring configuration.

Step2  Select Tools > Create P-Ring from the menu. The New Protected Ring window appears (Figure 2-26).

Figure 2-26 New Protected Ring Window
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Step3  Enter the number of present demand channels in the Num. of Channels field.
Step4  Enter the number of forecasted demand channels in the second Num. of Channels field.
Step5  Select a service type from the Client Service Type drop-down list.

~

Note  Refer to the “2.3.2.3 Adding Services” section on page 2-24 for a detailed list of the items in
the Client Equipment Type and Client Service Type fields.

Step 6 In the Protection Sites area, click All Sites to add all the sites in the ring as protection sites, or click Edit
to add individual sites. Clicking Edit displays the Protection Sites window (Figure 2-27).

~

Note If you click All Sites, skip to Step 13.
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Figure 2-27 Protection Sites Window
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Step 7 Select one or more sites in the List of Sites area.

Step8  Click Add to add the sites to the Selected Sites area.

Step9  Click Add All to add all of the sites to the Selected Sites area.

Step10 Select one or more sites in the Selected Sites are and click Remove to remove sites from the area.
Step11  Click Remove All to remove all of the sites from the Selected Sites area.

Step12 Click OK to display the selected protection sites in the Protection Sites area of the New Protected Ring
window. Click Cancel to close the window without making any changes.

Step 13  If you want to add optical bypass sites, click Edit in the Optical Bypass area. The Optical Bypass Sites
window appears (Figure 2-28). If you do not want to add optical bypass sites, proceed to Step 20.
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Step 15
Step 16
Step 17
Step 18
Step 19

Step 20
Step 21
Step 22
Step 23

2.4 Analyzing the Network W

Figure 2-28 Optical Bypass Sites Window
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The Optical Bypass Sites window lists any sites that are not part of the protection scheme.

Select one or more sites in the List of Sites area.

Click Add to add the sites to the Selected Sites area.

Click Add All to add all of the sites to the Selected Sites area.

Select one or more sites in the Selected Sites are and click Remove to remove sites from the area.
Click Remove All to remove all of the sites from the Selected Sites area.

Click OK to display the bypass sites in the Optical Bypass area of the New Protected Ring window. Click
Cancel to close the window without making any changes.

Choose a DWDM interface type.
Select a DWDM card type from the drop-down list.
Select a client interface source from the drop-down list.

Click OK to create the protected ring group, or click Cancel to close the window without saving any
changes.

2.4 Analyzing the Network

After you have placed the desired sites, spans, and service demands, click Analyze Network to examine
the network performance. MetroPlanner automatically optimizes the design and summarizes the optical
transmission performance in a summary report.

The Analyzer perform the following checks concerning the Any-to-Any and Any Client pattern:
¢ ROADM nodes cannot be used in conjunction with following node types:

— HUB/Full-OADM (multi-hubbed ring cannot have ROADM units)
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— OADM (both active and passive)

Note  These constraints allows MetroPlanner to simultaneously define ROADM (Any-to-Any), fixed and
P-Ring traffic on the same network if all the added/dropped sites are ROADM, and if neither OADM nor
Hub/Full-OADM sites are defined in the same network (with the exception of linear networks, where
end sites must be terminal sites).

e Networks with Any-to-Any clients only support 32-channel Metro-Core algorithms.

After the network has been analyzed, MetroPlanner changes the appearance of the boosters and
preamplifiers associated with the sites (Figure 2-29).

Figure 2-29 Booster and Preamplifier Examples

124746

Table 2-4 Booster and Preamplifier Example Legend

Number Description

1 East booster—unforced

2 East preamplifier—unforced
3 West booster—forced

4 West preamplifier—forced

2.4.1 Network Analysis Summary Tab

The Summary tab (Figure 2-30) is divided into four areas: Design Info, Optical Results, Design Cost
Info, and Other Reports. The Design Info area displays information about the network. It is similar to
the information found in the Add Network Wizard window (Figure 2-15).
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Figure 2-30 Summary Tab
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| Analyzed

The Optical Results area displays the number of fixed, BLSR, and ROADM demands. The color in the
columns indicate whether or not the current network design meets the requirements for the start to end
of the equipment life. If a cell is green, the current design meets the requirements. If a cell is yellow or
orange, the design is marginal. If the cell is red, the current network design does not meet the

requirements for proper operation. Click the blue Optical Results Report text to view the Optical Results
tab.

The Design Cost Info area displays the global discount percentage, the discounted required parts cost,

the discounted spare parts cost, and the total discounted network cost. Click the blue Network Bill Of
Material text to view the network bill of materials.

The Other Reports area allows you to view other MetroPlanner reports by clicking on the different
selections in the area.

2.4.2 Viewing the Optical Results Tab

Step 1

The Optical Results tab allows you to view the optical results of the network you created and analyzed.

You can launch the Optical Results tab from the Summary window, or by selecting Reports > Optical
Results from the menu. The Optical Results tab (Figure 2-31) appears.
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Figure 2-31 Optical Results Tab
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Table 2-5 displays the various buttons and lists that appear on all the tabs.

Table 2-5 Tab Icons

Button Description
3 Expand Header—Shows an expanded view of the header, including design
information.

Shrink Header—Shows the default view of the header, without the additional design
information.

Dock View to Bottom Area—Moves the tab information to the bottom of the screen.

Dock View to Center Area—Moves the tab information from the bottom area to the
default center view.

Undock View on Desktop—Moves the tab information to a separate window on the
desktop. Click Dock View to Center Area or Dock View to Bottom Area to move the
tab information back to the tab view.

Export Report—Opens the Export Report window, which allows you to export the tab
information to a text or HTML file.

m  oF g B

= Show Messages Detail—Opens the Analyzer Messages window, which shows you
&) Messages any messages pertinent to the current network design.
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Table 2-5 Tab Icons (continued)

Button

Description

9 Errors

Show Errors Detail—Opens the Analyzer Messages window, which displays any
error messages that occurred when you analyzed the network. It indicates that the
network may not be feasible.

Run New Query—Opens the Optical Results Query Dialog Window.

Mew guery
. |The EOL drop-down list allows you to filter the tab information. You can select
EOL bl start-of-life (SOL) information, EOL information, or both.
The P/F drop-down list allows you to filter the tab information for present
Py - information, forecast information, or both.
M Go to the first page of the report.
Go back 10 pages in the report.
4
Go to the previous page.
4
272 Displays the current page number and the total number of pages in the report.
b Go to the next page.
Go forward 10 pages in the report.
b
Go to the last page in the report.
b
Step 2 To change the table view to show SOL information, EOL information, or both, chooses a view from the
SOL/EOL Filter drop-down list.
Each row in the tab shows the performance of one optical path. A protected channel has two paths, and
therefore four rows. Table 2-6 describes the information in the columns.
Table 2-6 Network Optical Channel Results Tab Columns
Column Label Description
# Displays the identification number automatically given to each path in the order
that the channels were entered into the design.
SOL Displays the results of the start of life analysis. The indicator displays the optical
performance for the path. Green indicates success, yellow indicates success with
a marginal failure risk (between 0-16%), orange indicates the channel has a
higher risk of failure (between 16-50%), and red indicates failure.
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Step 3

Table 2-6 Network Optical Channel Results Tab Columns (continued)

Column Label Description

EOL Displays the end of life analysis. The indicator displays the optical performance
for the path at the end of the fiber’s life. Green indicates success, yellow indicates
success with a marginal failure risk (between 0-16%), orange indicates the
channel has a higher risk of failure (between 16-50%), and red indicates failure.

Traffic Group Displays the Traffic Group name for ROADM and P-Ring traffic. Displays the

Label predefined string "Fixed" for fixed traffic.

Srv Circuit Label

Displays the service circuit name. This field is optionally entered from the
Channel Dialog window.

P/F Displays the present/forecast services indication.

Source Displays the name of the source site.

Dest Displays the name of the destination site.

Side Identifies the side of the source site that each path of the service circuit leaves.

Protect Displays the protection type of the channel. For a protected channel, both paths
are shown. The path leaving the east side of the source is shown first.

Wavelength Displays the assigned wavelength of the optical path.

Span (km) Displays the total span (source -> destination) for this path in kilometers.

TX type Displays the type of transceiver that is the DWDM Card Type (see
2.3.2.3 Adding Services).

BER target Displays the bit error rate (BER) target for this channel based on the capability
of the channel’s optical interface. It is 1.0E-15 for the interfaces using forward
error correction (FEC) and 1.0E-12 for interfaces without FEC.

OSNR (dB) Displays the SOL/EOL average OSNR value at the receiver. OSNR refers to the
selected RBW bandwidth.

OSNR Margin Displays the OSNR margin.

RX (dBm) Displays the SOL and EOL received average power at the destination site.

Power Margin
(dB)

Displays the power budget margin at the receiver. It is defined as the offset
between the receiver working point and the “BER curve with margin.” A positive
value indicates no power problems.

Overload Margin
(dB)

Displays the overload margin at the receiver. A positive value indicates no
overload problems.

RX atten Displays the attenuator at the input of the receiver.

PMD (ps) Displays the calculated total PMD for each circuit. If the overall PMD for the link
overcomes the maximum allowed, the PMD value is colored red. The maximum
allowed value depends on the client interface. For these special cases, the
network must be manually resolved by contacting a Cisco optical sales engineer.

Latency Displays the latency time for the current circuit.

Chr Disp Check Displays the status of the chromatic dispersion check. Green indicates that the

dispersion check passed. Red indicates that the dispersion check failed.

Use the directional buttons at the bottom of the tab to scroll forward and backward through the optical

results pages.
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Step4  Click Shrink Header to hide all the table header information.

Step5  Click Export Report to export the optical results information to a file. You can save the file as an HTML
file, or as a tab-separated text file that can be opened by several applications.

Step6  Click New Query to open the Optical Results Query Dialog window (Figure 2-32). The Optical Results

Query Dialog window allows you to filter the optical results using a variety of parameters and templates.

Figure 2-32 Optical Results Query Dialog Window
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hd |
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Query Preview
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ME TAPF w/FEC :: Conhectivity = any :: wavelength = 1530.3 :: Direction
= East to West :: alarm = Green :: P/F =
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Table 2-7 describes the fields on the Optical Results Query Dialog Window.

Table 2-7 Optical Results Query Dialog Window Fields

Column Label Description

Group Selecting a traffic group filters the report to include only the data in the selected
group. You can also view groups on the tree view under the Network root.

Demand Selecting a traffic demand filters the report to include only the data in the

selected demand. The demand field is available only when you select a specific
traffic group.

DWDM Card Type |Selecting a card type filters the report to include only the data in the selected

DWDM card type.

Allows you to filter only the results of incoming/outgoing services to or from a
specific site (if you select Any), or between a pair of sites (if both are specified).
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Table 2-7 Optical Results Query Dialog Window Fields (continued)

Column Label Description

Direction Allows you to filter for services that are routed in the specified direction. The
direction refers to the fiber transmitting direction.

Wavelength Allows you to filter for services using the specified wavelength.

Alarm Allows you to filter for services flagged with a green, yellow, orange, or red
indicator.

P/F Allows you to filter for present services, forecast services, or both.

Virtual Allows you to include or exclude virtual channels in the Optical Results Table.

Step7  To perform a query using individual parameters, select the desired parameters from the 10 drop-down
lists in the Query Definition area. The selected parameters appear in the Query Preview area at the
bottom of the screen.

Step8  To perform a query using a pre-defined query template, select a template from the Query Templates
drop-down list and click Init From Template. The parameters included in the template appear in the
Query Preview area.

Step9  Click Run Query. The window closes, and the query results appear in the Optical Results tab. The
parameters of the query appear in the horizontal area just below the button bar.

Step10  Click Reset Query to clear your selections in the Optical Results Query Dialog window, or click Close
to close the window without running a query.

Step11  To view a demand’s optical channel result at any time, right-click on the desired traffic demand in the
tree view and select Optical Results.

Step12  Click Messages on the tab to view the Analyzer Messages window (Figure 2-33), which displays any
messages that occurred during the network analysis. If there are any errors in the analysis, click Errors
to view the error messages in the window.

N

Note  You can also select Reports > Show Messages to view the Analyzer Messages window.

Figure 2-33 Analyzer Messages Window
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Step13  Click OK to close the Analyzer Messages window.

Step14  Click Dock View to Bottom Area to position the Optical Results tab below the Network tab. Click it
again to return to the previous view.

Step15 Click Undock View on Desktop to detach the Optical Results tab and view it as a stand-alone window.
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2.5 Editing and Viewing Network Components ||

Click Dock View to Center Area to return to the previous view.

2.5 Editing and Viewing Network Components

MetroPlanner allows you to edit and view the network components either before or after the analysis.
Error messages that occur during the analysis often cannot be resolved until you edit one or more
network components.

2.5.1 Editing Site Parameters

Step 1
Step 2
Step 3

Step 4
Step 5

Step 6

Step 7

Editing the site parameters allows you to make changes to the current site configuration.

Create or open a network design.
Click Edit on the menu bar.

Double-click a site in the main MetroPlanner window, or right-click a site and select Edit Site from the
menu. The Site Dialog window (Figure 2-19) appears.

The window displays site, rack, shelf, slot, and card information, in addition to the site parameters, type,
and amplifier information you selected when you created the site. The window is divided into three areas.
The area on the far left contains the information you entered when you created the site. The middle area
contains a button bar and expandable nodes that represent the site, racks, shelves, and additional
equipment. The area at the far right contains a graphical representation of the site, racks, and shelves.

Make any changes to the fields as described in the “2.3.2.1 Adding Sites” section on page 2-19.

To change the layout of the node graphic, right-click on the tree root site icon and select Layout
Customization. A sub-menu opens, displaying the following custimization options: AIC, Fibre Storage,
and Patch Panels.

Select the items you want to display on the node graphic. The node graphic updates in real-time to
display the selected item.

Although there are two distinct patch panel options, the final network design only contains a single
option that applies to both. The patch panel options are only available for Hub, Full OADM and Terminal
site types. For Terminal types, only one patch panel is added/removed. For Hub and Full-OADM types,
both patch panels are added/removed.

~

Note If you change the network design after the design has been analyzed, the changes are applied
immediately to the site layout without having to re-analyze the network.

Click OK to save the changes and close the window.
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)

Note  You can only make site changes before running the network analysis. If you need to make changes to a
site that is a part of an analyzed network, click Design Mode on the menu bar to revert the network to
the design mode, where you can edit the site. You must then run the Network Analyzer again to obtain
a valid network configuration.

2.5.2 Displaying Shelf Configurations

After analyzing the network design, you can examine the shelf configuration for each of the sites using
the Edit Site dialog box.

Step 1 Click Edit and double-click a site in the Network tab to display the Site Dialog window (Figure 2-34).

Figure 2-34 Site Dialog Window Showing Shelf Configuration
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Step2  Double-click different areas of the graphic on the far right of the window to see information specific to
that rack, shelf, or card. A separate window appears, displaying information for the selected item.
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Figure 2-35 Sample Report Window
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The information displayed in the window varies from item to item. See Table 2-8 for a complete listing
of the tabs and columns available in the window.

Table 2-8  Site Dialog Report Window Tabs and Columns

Tab Column Description
Info Property Displays the categories of information available
for the selected item.
Value Displays the actual item description.
Modules P/F Displays the present and forecast module
information.
Module PID Displays the module part number.
Ch # Displays the channel number.
Description Displays the description of the module.
Items Item PID Displays the item part number.
Category Displays the category to which the item belongs.
Description Displays a description of the item.
Count Indicates the number of these items present.
Notes Displays any notes available for the item.
Connections Port Displays the port name.
Conn. Port Displays the connection port name.
Conn. Card Displays the connection card name.
Conn. Position Displays the position of the connection.
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Table 2-8 Site Dialog Report Window Tabs and Columns (continued)

Tab Column Description
Services Service Filtering Option |Select a filtering option for the services. Choices

are None, Only Added, Only Dropped, Only
Express, and Only Optical Bypass.

Service Label Displays the service label.

Src Site Displays the source site name.

Src Pos Displays the source rack and shelf position.

Src Unit Displays the source card (unit) name.

Src Port Displays the source port.

Dest Site Displays the destination site name.

Dest Pos Displays the destination rack and shelf position.

Dest Unit Displays the destination card (unit) name.

Dest Port Displays the destination port.

Cl. Service Displays the client service type.

Protection Displays the current protection scheme.

ITU Ch. Displays the ITU channel.

Op. Bypass Displays the name of the optical bypass site.

Cl. Interf. Displays the DWDM interface type (transponder
or line card).

Cl. Card Displays the DWDM card type.

Step3  Click Zoom In and Zoom Out on the button bar to view more or less detail on the graphic.
Step4  Click either the left or right arrow button to view information for the next or previous site in the network.

Step5  To view the site layout in table format, click View Layout As Table. The site information appears as a
separate window in table format, allowing you to export to an external application, if you desire.

Step6  To export the layout to an image file, click Export View To Image.

Step 7 To exit the shelf layout window, click Cancel.

2.5.3 Deleting a Site

Perform the following steps to delete an existing site from the network design.

Step1  Right-click the site in the main MetroPlanner window and select Delete Site from the menu. A
confirmation message appears, asking you to confirm the deletion of the site.

Step2  Click Yes to delete the site.
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Note

2.5.4 Editing Service Demand Allocations

If the site has associated service demands or channels, you must first delete those demands or channels
before deleting the site.

2.5.4 Editing Service Demand Allocations

Step 1
Step 2
Step 3

You can change the distribution of services in a group of fixed or P-ring service demands as well as view
the service requests between to sites using the following steps.

Create or open a network design.

Click Edit Mode on the menu bar.

Double-click a channel/service in the main MetroPlanner window, or right-click a service and select Edit
Service from the menu. The Service Table window (Figure 2-36) appears.

Figure 2-36 Service Table Window
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The Services Table window displays information about the selected service. Table 2-9 lists the fields and

columns and their descriptions.

Table 2-9  Service Table Columns

Column/Field Label

Description

Srv. Demand Label

Displays the service demand label.

Source Displays the name of the source node.

Destination Displays the name of the destination node.

P/F Present and Forecast. This column displays “P&F” if services are configured
both currently and in the future. If services are for future only, “F” is displayed.
If services are configured only for current activity, “P” is displayed.

C1 Srv. Type Displays the client service type.

Protection Type

Specifies the protection type, if any. You can force routing of service by selecting
Unprotected-East or Unprotected-West from the drop-down list.
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Step 4

Step 5
Step 6
Step 7

Step 8

Table 2-9  Service Table Columns (continued)

Column/Field Label |Description

ITU Ch (opt) Displays the ITU channel of the service demand. You can force the channel
number by selecting a new channel from the drop-down list in the field.

Op. Bypass Site Displays the name of the optical bypass site, if one is assigned.
Name

DWDM Interface |Displays the DWDM interface type.
Type

DWDM Card Type |Displays the DWDM card type.
(opt)

To display the Service Demand Dialog window, double-click a row, or select a row and click
Edit Service Circuit. The Service Demand Dialog window (Figure 2-22) appears, allowing you make
changes to the service.

N

Note  You can only make service changes before running the network analysis. If you need to make
changes to a service that is a part of an analyzed network, click Design Mode on the menu bar
to revert the network to the design mode, where you can edit the service. You must then run the
Network Analyzer again to obtain a valid network configuration.

Make any changes to the fields as described in the “2.3.2.3 Adding Services” section on page 2-24.
To delete a service, select the service and click Remove Service Circuit.

To add a service group, click the Add Service Group button. The Service Demand Dialog window
appears, allowing you to create a new service.

Click OK to save the changes and close the window.

2.5.5 Editing Fiber Span Parameters

Step 1
Step 2
Step 3

Editing the fiber span parameters allows you make changes to fiber type, span length, and other
fiber-related items.

Create or open a network design.
Click Edit Mode on the menu bar.

Double-click a fiber span in the main MetroPlanner window, or right-click the fiber span and select
Edit Fibre from the menu. The Fibres Dialog window (Figure 2-20) appears, allowing you to make
changes to the fiber span.

)

Note  You can only make fiber changes before running the network analysis. If you need to make
changes to a fiber that is a part of an analyzed network, click Design Mode on the menu bar to
revert the network to the design mode, where you can edit the fiber. You must then run the
Network Analyzer again to obtain a valid network configuration.
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Step4  Make any changes to the fields as described in the “2.3.2.2 Adding Fiber Spans” section on page 2-22.
Step5  To save the changes, click OK.

2.5.6 Deleting a Fiber Span

Perform the following steps to delete a fiber span from the network design.

Step 1 Right-click the fiber and select Delete Fibre from the menu. A confirmation dialog box appears, asking
you to confirm the fiber deletion.

Step2  Click Yes to confirm the fiber deletion.

2.5.7 Viewing the Traffic Matrix

The Traffic Matrix window displays information about the external connections on the client side.

S,
Note  When opened from the menu, the Traffic Matrix appears blank until after you run a query from the

Traffic Matrix tab. See Step 6 of “2.4.2 Viewing the Optical Results Tab” section on page 2-33 for
information on running a query.

Step1  Create or open an analyzed network.

Step2  Select Reports > Traffic Matrix. The Traffic Matrix window appears (Figure 2-37). The query runs
automatically, displaying information based on the selected item in the tree view. You can also view the
traffic matrix for a specific demand by right-clicking the desired traffic demand in the tree view
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Figure 2-37 Traffic Matrix Window
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Table 2-10 describes the information in the Traffic Matrix window.

Table 2-10 Traffic Matrix Columns

Column Name

Description

Traffic Group Label

Displays the traffic group name for ROADM and P-Ring traffic. Displays
the predefined string "Fixed" for fixed traffic.

Srv. Circuit Label

Displays the service circuit label.

Source

Displays the source site name.

Src. Side

Displays the source side of the site (east or west).

Src. IP Address

Displays the IP address of the source site.

Src. Position

Displays the source rack and shelf position.

Src. Unit Displays the source card (unit) name.

Src. Port Displays the source port.

Destination Displays the destination site name.

Dest. Side Displays the destination side of the site (east or west).

Dest. IP Address

Displays the IP address of the destination site.

Dest. Position

Displays the destination rack and shelf position.

Dest. Unit

Displays the destination card (unit) name.

Dest. Port

Displays the destination port.

Cl. Service Type

Displays the client service type.

Protection Type

Displays the current protection scheme.
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Table 2-10 Traffic Matrix Columns (continued)

Column Name Description

Wavelength Displays the wavelength.

Op. Bypass Site Name Displays the name of the optical bypass site.

DWDM Interface Type | Displays the DWDM interface type (transponder or line card).

DWDM Card Type Displays the DWDM card type (10G MR TXP w/FEC or 10G MR TXP
w/o FEC).

Step3  Click Shrink Header to hide the text that appears above the table rows.

Step4  Click Export Report to save the information to an external file. The Save Table window appears,
allowing you to enter or select an HTML or text file name.

Step5  Click Messages to view the Analyzer Messages window (Figure 2-33).

Step6  Click Dock View to Bottom Area to position the tab below the Network tab. Click it again to return to
the previous view.

Step7  Click Undock View on Desktop to detach the tab and view it as a stand-alone window.

Step8  Click Dock View to Center Area to return to the previous view.

2.5.8 Viewing the Wavelength Routing

The Wavelength Routing Map allows you to view a graphical traffic display of all the present and
forecast, fixed and protected ring routed circuits in the network.

Step 1 Create or open an analyzed network.

Step2  Select Reports > Wavelength Routing from the menu. Alternatively, you can open the Wavelength
Routing window by clicking View Reports and selecting Wavelength Routing from the drop-down. The
Wavelength Routing tab appears (Figure 2-38).
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Step 3

Step 4
Step 5

Step 6
Step 7
Step 8

Step 9
Step 10

Figure 2-38 Wavelength Routing Tab
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Each row represents a wavelength. The Wavelength Routing tab displays all the wavelengths, not just
the wavelengths used by the network design. Each column represents the sites and each bidirectional
span. The site columns are subdivided into two other columns, which represent the east and west side of
the site.

Each bidirectional routed channel is represented by a line starting from the source site to the destination
site through the sites and spans traversed by the channel. Protected circuits are represented by two
distinct routes.

Place the cursor over the different sections of the map to display tool tip information about the routed
circuits. The tool tips display the circuit label, service circuit type, protection type, and the DWDM card

type.
Click Shrink Header to hide the text that appears above the table rows.

Click Export Report to save the information to an external file. The Save Table window appears,
allowing you to enter or select an HTML or text file name.

Click Export Report As Image to save the information in the map to an external image file.
Click Messages to view the Analyzer Messages window (Figure 2-33).

Click Dock View to Bottom Area to position the tab below the Network tab. Click it again to return to
the previous view.

Click Undock View on Desktop to detach the tab and view it as a stand-alone window.

Click Dock View to Center Area to return to the previous view.
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2.5.9 Viewing the Link Availability

Step 1
Step 2

MetroPlanner provides the ability to view a link availability table listing an availability value (as a
percentage) for each circuit in the network. MetroPlanner defines the value globally for the circuit, and
factors in both paths for protected circuits. For BLSR/MSP-Ring-type ring protection, link availability
is provided for each individual service circuit.

Create or open an analyzed network.

Select Reports > Link Availability. Alternatively, click View Report and select Link Availability from
the list, or right-click an item in the tree view and select Link Availability.

~

Note

Opening the Link Availability window via right-click displays all the circuits in the subtree in
the window.

The Link Availability tab appears (Figure 2-39).

Figure 2-39 Link Availability Tab
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Table 2-11 describes the information in the Link Availability tab.

Table 2-11 Link Availability Tab Columns

Column Name
Traffic Group Label

Description

Displays the traffic group name for ROADM and P-Ring
traffic. For fixed traffic, it displays the predefined string
“Fixed”.

Service Circuit Label Displays the service circuit label.

Source Displays the service circuit source site name.

Destination Displays the service circuit destination site name.

Protection Type Displays the service circuit protection type.

[ october 2004

Cisco MetroPlanner DWDM Operations Guide, Release 25 g



Chapter2  Designing Networks with MetroPlanner |

I 25.10 Modifying the Filter Wavelengths

Step 3
Step 4

Step 5
Step 6

Step 7
Step 8

Table 2-11 Link Availability Tab Columns (continued)

Column Name Description

DWDM Card Type Displays the client DWDM card type.

Link Availability% Complete  |Displays the link availability, in percentage complete.

Click Shrink Header to hide the text that appears above the table rows.

Click Export Report to save the information to an external file. The Save Table window appears,
allowing you to enter or select an HTML or text file name.

Click Messages to view the Analyzer Messages window (Figure 2-33).

Click Dock View to Bottom Area to position the tab below the Network tab. Click it again to return to
the previous view.

Click Undock View on Desktop to detach the tab and view it as a stand-alone window.

Click Dock View to Center Area to return to the previous view.

2.5.10 Modifying the Filter Wavelengths

Step 1
Step 2

After analyzing the network, you can force channels to any one of the wavelength bands supported by
the ONS 15454.

Create or open an analyzed network.

Choose Network > Bands Shifting from the menu bar. The Resulting Bands Map window will display
(Figure 2-40).
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Figure 2-40 Resulting Bands Map Window

Resulting Bands Map
I—l—l—l—l—l—

1,530.33 - 1,552.68

1 534,25 - 1,536.61

153619 - 1,540.56

154214 -1,544.53

154612 - 1,548.51

155012 - 1,552.52

155413 - 1,556.55

155617 - 1,560.61

The Resulting Bands Map window shows which wavelengths are in use in which bands. A used
wavelength is indicated by light blue shading in the cell.

124799

Step3  To switch the wavelengths to any available band, click on the drop down list in the Shifted Band column
to the right of the wavelength.

Step4  Select a wavelength from the drop-down list. The new wavelength then appears in the Shifted Band
column.

S

Note  The drop-down list only appears after you click in the cell.

Step 5 After switching bands, click OK to close the window, or click Cancel to close the window without
saving any changes.

2.5.11 Viewing the Sites Table

The Sites Table displays a list of the sites in the network and their IP addresses.

Step 1 Create or open a network design.

Step2  Select Network > Sites Table. The Sites Table appears (Figure 2-41).
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Figure 2-41 Sites Table

|1l Sites Table x|

Site name | IP address |
Site 1 255.255.254.1
Site 2 255.255,255.2
Site 3 255.255.255.3
Site 4 255.255.255.4

-+

OK | | Cancel 3

Step3  To copy the information in the window, right-click any row and select Copy Table.

Step4  To export the information to an external file, right-click any row and select Export Table. A Save Table
window appears, allowing you to enter or select a file name for the exported information. You can save
site table files as either HTML or text files.

Step5  Click Save.

Step6  Click OK or Cancel to close the Sites Table window.

2.5.12 Viewing the Span Table

The Span table displays a list of the spans in the network.

Step1  Create or open a network design.
Step2  Select Network > Span Table. The Fibres Dialog window appears (Figure 2-20).
Step3  Click OK to close the window.

2.5.13 Arranging Sites in the Network View

After creating a network, you can use MetroPlanner to automatically arrange the sites into several

configurations. MetroPlanner offers six different configurations.

2.5.13.1 Using the Square Configuration

The square configuration displays the network in a square format.

Step 1 Create or open a network design.
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Step2  Select Network > Arrange Sites > Square. The Square Shape Data Input window appears
(Figure 2-42).

Figure 2-42 Square Shape Data Input Window

Square shape data input

Sites spacing [13g| |

futo || oK || Cancel |

124754

Step3  Enter a number indicating the amount of space to place between the sites in the Sites Spacing field.
Higher numbers create larger spaces between sites.

Alternatively, click Auto to allow MetroPlanner to automatically place the sites at a predetermined
distance from each other.

Step4  Click OK to create the spacing, or click Cancel to close the window without applying the square
configuration. Refer to Figure 2-43.

Figure 2-43 Example of a Square Configuration

124753

2.5.13.2 Using the Ring Configuration

The ring configuration displays the network in a circular, or ring format.

Step 1 Create or open a network design.

Step2  Select Network > Arrange Sites > Ring. The Ring Shape Data Input window appears (Figure 2-44).
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Figure 2-44 Ring Shape Data Input Window

Ring shape data input

124780

Step3  Enter a number indicating the radius of the ring in the Ray field. A higher numbers creates a larger ring.

Alternatively, click Auto to allow MetroPlanner to automatically create a ring at a predetermined size.

Step4  Click OK to create the ring, or click Cancel to close the window without applying the ring configuration.

Refer to Figure 2-45.

Figure 2-45 Ring Configuration Example

1,674
0.40 dB E-lEE>

Site 3

124749

25.13.3 Using the Ellipse Configuration

The ellipse configuration displays the network in a oval, or ellipse format.

Step1  Create or open a network design.

Step2  Select Network > Arrange Sites > Ellipse. The Ellipse Shape Data Input window appears

(Figure 2-46).

Figure 2-46 Ellipse Shape Data Input Window

Ellipse shape data input

Hray [182 |

Y ray [124 |

124745
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Enter a number indicating the length of the ellipse in the X Ray field. Higher numbers create longer
ellipses.

Enter a number indicating the height of the ellipse in the Y Ray field. Higher numbers create wider
ellipses.

Alternatively, click Auto to allow MetroPlanner to automatically create an ellipse of a predetermined
size.

Click OK to create the spacing, or click Cancel to close the window without applying the ellipse
configuration. Refer to Figure 2-47.

Figure 2-47 Ellipse Configuration Example

1.
0.40dB

124744

Site 3

2.5.13.4 Using the Snake Configuration

Step 1
Step 2

Step 3
Step 4

The snake configuration displays the network in a serpentine, linear format.

Create or open a network design.

Select Network > Arrange Sites > Snake. The Snake Shape Data Input window appears (Figure 2-48).

Figure 2-48 Snake Shape Data Input Window

Snake shape data input |

Sites per row 4] |

Haorizantal spacing (150 |

Vertical spacing [150 |

ato | o || cancel |

124752

Enter a number indicating the number of sites to appear in each row in the Sites Per Row field.

Enter a number indicating the amount of space required between each site in the Horizontal Spacing
field. Higher numbers create wider spaces between sites.
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Step 6

Enter a number indicating the amount of space required between each row in the Vertical Spacing field.

Higher numbers create wider spaces between rows.

Alternatively, click Auto to allow MetroPlanner to automatically create a snake configuration of a

predetermined layout.

Click OK to create the spacing, or click Cancel to close the window without applying the snake

configuration. Refer to Figure 2-49.

Figure 2-49 Snake Configuration Example

25.13.5 Using the Double Ring Configuration

Step 1
Step 2

Step 3

The double ring configuration displays the network in a dual ring format.

Create or open a network design.

Select Network > Arrange Sites > Double Ring. The Double Ring Shape Data Input window appears

(Figure 2-50).

Figure 2-50 Double Ring Shape Data Input Window

Double ring shape data input

Inner ray (100 |

Outer ray 200 |

| awo | o || cancel |
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Enter a number indicating the radius of the inner ring in the Inner Ray field. Higher numbers create

bigger rings.
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Step4  Enter a number indicating the radius of the outer ring in the Outer Ray field. Higher numbers create
bigger rings.

Alternatively, click Auto to allow MetroPlanner to automatically create a double ring configuration of a
predetermined size.

Step5  Click OK to create the spacing, or click Cancel to close the window without applying the double ring
configuration. Refer to Figure 2-51.

Figure 2-51 Double Ring Configuration Example

124742

2.5.13.6 Using the Fit to Window Configuration

Use the Fit to Window configuration to adjust any existing configuration so that it fills the MetroPlanner
window.

Step1  Create or open a network design.

Step2  Select Network > Arrange Sites > Fit to Window. The configuration expands or contracts to fit within
the MetroPlanner window.
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2.6 Saving and Loading Network Designs

MetroPlanner provides the capability to save network designs for future reference.

Step1  To save a network design to disk, click Save. If the design has not yet been saved to a file, a File
dialog box appears, asking you to select a file path and specify a file name. MetroPlanner saves network
designs with the extension “cmn”.

Step2  To load a network design from disk, click Open. The Select Network File dialog box appears, asking
you to select a file path and specify a file name.

~

Note  Network designs that were created in releases of MetroPlanner prior to Release 2.3 are
incompatible with MetroPlanner R2.5.

Step3  To save the existing design with a new name, choose File > Save As. A File dialog box appears, asking
you to select a file path and specify a file name.

2.7 Completing the Network Design

After creating, analyzing, and modifying the network design, you must prepare the design for
installation at a customer site.

2.1.1 Freezing and Unfreezing the Network Layout

When the network design is in Install status, you can freeze and unfreeze the network layout, or the
individual sites in the layout. Freezing a site forces the presence or absence of all preamplifiers, boosters,
add/drop filters, and DCU units required by the site/network as a result of running the Network Analyzer
previously.

The Install status refers to the current state of the network design. Network designs have several states,
as follows.

e Design—The initial status for any new network design. You can add, delete, or change any aspect
of the network design.

¢ Design-Analyzed—The status of the network design after you run the Network Analyzer. All the
result tables are available and updated. You cannot change any aspect of the network design. You
can also modify BOM aspects, such as global discounts and spare part management.

¢ Install—The status of the network after clicking Install Mode. Moving into the Install state from
the Design-Analyzed state automatically freezes all the sites in the design. You cannot modify any
aspect of the network design except the span parameters and (on unfrozen sites) amplifier forcing.
You can modify the BOM. All routed circuits are fixed, and cannot be changed while in this state.

¢ Installed-Analyzed—The status of the network after running the Network Analyzer on a network in
the Install state. MetroPlanner updates the results tables. You cannot modify any aspect of the
network design except the span parameters and the amplifier forcing. All routed circuits are fixed,
and cannot be changed while in this state.

MetroPlanner saves the state of the network along with the network itself.
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Step1  Create or open a network design.

Step2  Click Install Mode to move the design into the Install state. All the sites in the network automatically
freeze. Frozen sites are indicated by a closed padlock on the site (Figure 2-52).

Figure 2-52 Frozen Site Example

@ Site 1

/mﬁl}.;';]@@&

Step3  To unfreeze all the sites in the network, select Network > Install > Layout Unfreezing. The padlock
disappears.

Step 4 To unfreeze an individual site, right-click the frozen site and select Network > Install >
Site Layout Un-Freezing.

Step5 To freeze the entire network, select Network > Install > Layout Freezing.

2.1.2 Viewing Internal Connections

You can view the network internal connections after the network has been analyzed, and when it is in the
Install state. You can also view the patch cord connections between transponders and Y-Cable Protection
FlexLayer modules. The Y-Cable Protection FlexLayer position is defined using the rack and shelf
number resulting from the layout position, and the slots are numbered from left to right on each of the
four FlexLayer modules that can be placed in a shelf.

Step1  Create or open a network design.
Step2  Analyze the network.

Step3  Select Reports > Internal Connections from the menu. The Internal Connections tab appears
(Figure 2-53).
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Figure 2-53 Internal Connections Tab

& Network

B internal Connections |

[al

L F DMessages T B [pr = 08-02-04 at12:03:41 B3
Site IF
‘ Address ‘ Position-1 Unit-1 ‘ Part #1 ‘ Port 11 Port Label-1 ‘ Attenuator
Site 1 | 255.255.255.1 | Rack#1.Main Shelf03 | 15454-AD-4C-541 1 CHAN-3-1-R¥ | 1554.1-Rx
Site 1 |255.255.255.1 | Rack#1.Main Shelf03|15454-AD-4C-541| 2 CHAN-3-1-T | 1554.1-Tx
Site 1 |255.255.255.1 |Rack#1.Main Shelf03|15454-AD-4C-541| 3 | CHAN-3-2-R¥ | 1554.9-R¥
Site 1 |255.255.255.1 | Rack#1.Main Shelf03|15454-AD-4C-541| 4 CHAN-3-2-TH | 1554.8-Tx
Site 1 |255.255.255.1 |Rack#1.Main Shelf14 | 15454-A0-4C-541| 5 CHAN-14-3-R¥| 1555.7-R¥
Site 1 |255.255.255.1 |Rack#1.Main Shelf03|15454-A0-4C-541| 5 | CHAN-3-3-RX | 1585.7-R¥
Site 1 |255.255.255.1 |Rack#1.Main Shelf 14| 15454-A0-4C-541| 7 CHAN-14-4-R¥| 1556.5-R¥
Site 1 |255.255.255.1 | Rack#1.Main Shelf03|15454-A0-4C-541| 7 | CHAN-3-4-R¥ | 1556.5-R¥
Site 1 |255.255.255.1 | Rack#1.Main Shelf 15| 15454-A0-4C-581| 1 CHAN-15-1-R¥| 1558.1-R¥
Site 1 |255.255.255.1 | Rack#1.Main Shelf04 | 15454-AD-4C-581 | 1 CHAN-4-1-R¥ | 1558.1-Rx
Site 1 |255.255.255.1 | Rack#1.Main Shelf 15| 15454-A0-4C-581| 3 CHAN-15-2-R¥| 1558.9-R¥
Site 1 |255.255.255.1 | Rack#1.Main Shelf04 | 15454-A0-4C-581| 3 | CHAN-4-2-R¥ | 1558.9-R¥
Site 1 |255.255.255.1 |Rack#1.Main Shelf04 | 15454-AD-4C-581| 5 | CHAN-4-3-RX | 1559.7-R¥
Site 1 |255.255.255.1 | Rack#1.Main Shelf04 | 15454-AD-4C-581| 6 CHAN-4-3-T | 1550.7-Tx
Site 1 |255.255.255.1 | Rack#1.Main Shelf04 | 15454-A0-4C-581| 7 | CHAN-4-4-R¥ | 1560.6-RX
Site 1 |255.255.255.1 | Rack#1.Main Shelf04 | 15454-AD-4C-581| 8 CHAN-4-4-T | 1560.6-Tx
Site 1 |255.255.255.1 | Rack#1.Main Shelf01| 15454-0PT-BST 1 LINE-1-1-R¥ | COM-Rx
Site 1 |255.255.255.1 | Rack#1.Main Shelf 17| 15454-05C-CEM 1 LINE-17-1-R¥ | COM-RX
Site 1 |255.255.255.1 | Rack#1.Main Shelf02| 15454-0PT-PRE 1 LINE-2-1-R¥ | COM-Rx
Site 1 |255.255.255.1 | Rack#1.Main Shelf16| 15454-0PT-PRE 2 LINE-16-1-T | COM-TX
Cita 1 28388 381 Pacl® Main Cholf1 7 18484 . 0SS Chd 2 LIRIE.A Tod T o T | ’I

116883

Table 2-12 lists the columns in the Internal Connections tab and their descriptions. Click on the columns
to sort the table information by the selected column.

Table 2-12 Internal Connections Tab Columns

Column Name

Description

Site

Displays the name of the site.

IP Address

Displays the site IP address.

Position-1

Displays the rack, shelf, and slot position of the unit (card) from which the patch
cord originates.

Unit-1

Displays the name of the unit (card).

Port #-1

Displays the port number from which the patch cord originates.

Port ID-1

Displays the port ID.

Port Label-1

Displays the name of the port.

Attenuator

When indicated, it is the PID of the bulk attenuator to be equipped on this
connection. It also reports information for when an internal attenuator must be
placed, between the DC-TX and DC-RX ports on the preamplifier when no DCU is
equipped.

Position-2

Displays the rack, shelf, and slot position of the unit (card) where the patch cord
terminates.

Unit-2

Displays the name of the unit (card).

Port #-2

Displays the port number where the patch cord terminates.

Port ID-2

Displays the port ID.

Port Label-2

Displays the name of the port.
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2.1.3 Viewing Installation Parameters 1l

Table 2-12 Internal Connections Tab Columns (continued)

Column Name Description

Manually Set Defines when the internal connection must be manually set by means of the local
craft terminal (CTC). The allowed values are:

¢ No—This connection is automatically set on the site by the TL1 agent software.
¢ Yes—This connection must be manually set using CTC (or TL1).
¢ Remove—This connection must be manually removed using CTC (or TL1).

Note Every connection listed in the report must be connected with patch cords,
except for connections marked “Remove”.

P/F Displays whether the connection relates to a present or forecast circuit.

Click Shrink Header to hide the text that appears above the table rows.

Click Export Report to save the information to an external file. The Save Table window appears,
allowing you to enter or select an HTML or text file name.

Click Messages to view the Analyzer Messages window (Figure 2-33).

Click Dock View to Bottom Area to position the tab below the Network tab. Click it again to return to
the previous view.

Click Undock View on Desktop to detach the tab and view it as a stand-alone window.

Click Dock View to Center Area to return to the previous view.

2.1.3 Viewing Installation Parameters

You can view the installation parameters of networks after the network has been analyzed, and when it
is in the Install state. The network installation parameters report the parameter values to be set
(provisioned) at installation time on each site in the network.

Step 1 Create or open a network design.
Step2  Click Install Mode to move the design into the Install state.
Step3  Select Reports > Installation Parameters from the menu. The Installation Parameters tab appears
(Figure 2-54).
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Figure 2-54 Installation Parameters Tab

& Network | Summary | tiin Optical Resutts | Link Availabilitw |
Traffic Matrix | Wavelength Routing | 2R Internal Connections @ Installation Parameters |
$F D Messages T, B 06-21-04 at05:04:45 B2
Site P hleasurement
T yor v | Side | Position | Unit | Port # | Port Il | Port Label | Paramater | Value | e |
Site 1 |255.255.2551  East SYSTEM_TYFE 1] string [a]
Site 1 |255.266.265.1 East Channel Power Fail Low -12.4 dBm
Site 1 | 2552652561 East 05C Power Fail Low -11.9 dBm
Site1 |255.255.25561 East Pin OADM Stage 20 dBm
Site 1 | 2552652561 East Fout OADM Stage -9.7 dBm
Site1 |255.255.25561 East Pout Band 54.1 -0.2 dBm
Site 1 | 2552652561 East Pout Band 53.1 0.0 dBm
Site1 | 255.255.2551 East FPower Fail Low [PRE Input] | -13.4 dBm
Site 1 |255.265.2561  West SYSTEM_TYFE ] string
Site 1 |255.255.255.1  ‘West Channel Power Fail Low -12.4 dBm
Site 1 |255.265.2561  West 0S5C Power Fail Low -11.9 dBEm
Site 1 |255.255.2551 West Pin OADM Stage 20 dBm
Site 1 |255.2595.25561  West Fout OADM Stage -10.0 dEm
Site 1 |255.255.2551 West Pout Band 54.1 0.2 dBm
Site 1 |255.2595.25561  West Pout Band 58.1 -0.3 dEm
Site 1 |1 255.255.25581 | West Power Fail Low [PRE Input] | -13.4 dBm
Site 2 |255.265.256.2  East SYSTEM_TYFE 0 string
Site2 |255.255.255.2 East Channel Power Fail Low -4.6 dBm
Site 2 |255.265.2566.2  East 0SC Power Fail Low -7 dBm
Site 2 |255.255.255.2 East Pin OADM Stage 0.4 dBm
Site 2 |255.265.2566.2  East Fout OADM Stage -3.8 dBm
Site 2 |255.255.255.2 East Pout Band 58.1 -18.7 dBm
Site 2 |285.265.256.2 West SYSTEM_TYFE 0 string
Site2 |255.255.255.2 ‘West Channel Power Fail Low -4.2 dBm T_ %
[2] o
Table 2-13 lists the columns in the Installation Parameters tab and their descriptions.
Table 2-13 Installation Parameters Tab Columns
Column Name Description
Site Name Displays the name of the site.
IP Address Displays the site IP address.
Side Indicates the side of the site from which the parameter originates (east or west).
Position Displays the rack, shelf, and slot position of the unit (card) from which the
parameter originates.
Unit Displays the name of the unit (card).
Port # Displays the port number (IDL port identifier) of the parameter.
Port ID Displays the port ID (TL1 identifier).
Port Label Displays the name of the port as displayed on the front panel of the unit.
Parameter Displays the name of the parameter.
Value Displays the value to be set for the installation parameter.
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2.7.4 Saving the Installation Assisted Configuration File

Table 2-13 Installation Parameters Tab Columns (continued)

Column Name Description

Measurement Unit |Displays the unit of measure for the parameter.

Manual Set Defines when the installation parameter must be manually set by means of the
local craft terminal (CTC). The allowed values are:

e No—This parameter is automatically set on the site using the assisted
configuration file.

* Yes—This parameter must be manually set using CTC (or TL1).

e Troubleshooting—This parameters is used to check if the measured value in
the specified point is the expected value.

The installation parameters vary, depending on whether they apply to the network, system, or site.
Click Shrink Header to hide the text that appears above the table rows.

Click Export Report to save the information to an external file. The Save Table window appears,
allowing you to enter or select an HTML or text file name.

Click Messages to view the Analyzer Messages window (Figure 2-33).

Click Dock View to Bottom Area to position the tab below the Network tab. Click it again to return to
the previous view.

Click Undock View on Desktop to detach the tab and view it as a stand-alone window.

Click Dock View to Center Area to return to the previous view.

2.1.4 Saving the Installation Assisted Configuration File

After MetroPlanner calculates the installation parameters, it can create a separated ASCII configuration
file for each site in the network. This file can be directly imported to a site using the NE Update feature
in Cisco Transport Controller (CTC). MetroPlanner generates one text file for each site in the network
in the MetroPlanner installation folder. Each file is named with the site name string by default.

Step 1 Create or open a network design.
Step2  Click Install Mode to move the design into the Install state.
Step3  Select Network > Install > Assisted Conf Setup. The Assisted Configuration Setup Save File window
appears (Figure 2-55).
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Figure 2-55 Assisted Configuration Setup Save File Window

Save In: ||l:| WetroFlanner >| & = jo B

1 maps
1 plugins
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Step4  Click Save to save the file to disk.

Step5  To change the directory, choose a new directory from the list, or use the drop-down list to select a
directory.

Step6  Click Cancel to close the window without saving a configuration setup file.

2.8 Ordering the Equipment

MetroPlanner provides features to help you order your Cisco ONS 15454 DWDM equipment. After you
complete the network design, you must create a unique order code (also referred to as an order
description). This allows the order to be placed via Cisco.com. The following steps describe the process
for creating an order code.

Step1  Choose Options > Order Parameters. The Order Parameters window appears (Figure 2-56).
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Figure 2-56 Order Parameters Window

Order parameters =

~Design Info

Design Wersion |1.1 |

Design Descriplion (e naic design version 1.1

Custamer Mame |Acme Qptics |
Freparad By |Cisc0 Systerms |
OK | | Cancel

115817

Step2  Enter the version of the design in the Design Version field.

Step3  Enter the description in the Design Description field.

Step4  Enter the name of the customer in the Customer Name field.

Step5  Enter the name of the designer in the Prepared By field.

Step6 Click OK. Click Cancel to close the window without saving any changes.

2.9 Generating a BOM

You can generate a BOM after you have successfully analyzed your network design.

2.9.1 Generating a Network BOM

Use the following steps to generate a BOM for the network.
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Step 1

Step 2

Step 3

Choose Reports > Network Bill Of Material to generate a BOM for the entire network. The Network
BOM window (Figure 2-57) appears.

Figure 2-57 Network BOM Window

< Metwork Bill of Material

ol

¥ B @ Messages S F 10-18-04 at11:54:53
MNetwork Total Discounted Price: §3,212,475.00
Global Discount Percentage ln—

P"’I'[’,“m Description | Ouantity | UnitPrice "e[‘,‘i”;‘;gf;‘"“ Tatal Price [;';';‘I"g::sg
15454-AIR-RAMP= OMS 15454 Air Ramp/ Bafile for th... 4 §120.00 0% §480.00 §430.00 |~
15454-FBR-5TRG= Fiber Storage Shelf 4 §e00.00 0% $3,200.00 §3,200.00
156454-5A-HD= 15454 SAMEBS3 AMSIwRCA an... ] $2,700.00 0% $16,200.00 $16,200.00
15454-BLANK Empty slot Filler Panel a3 §225.00 0% §7,425.00 §7.425.00
15454-TCC2 Timing Comrunications Contral ... 12 $4,500.00 0% $54,000.00 $54,000.00 Ef
15454-FTA3-T ShellFan Tray Assembly ANS 1. ] §r720.00 0% $4,320.00 §4,320.00
15454-METP-4. 75w= Rel. 4.7.0 MSTP Feature Pkg., CD, B $1,995.00 0% $11,970.00 $11,970.00
SF15454-M5TP-4.7 Rel. 4.7.0 5W, MSTP, Pre-loaded ... 12 $0.00 0% $0.00 $0.00
15454-05CHM= OM3 15454 Optical Service Chann... 3 $7,000.00 0% $21,000.00 $21,000.00
15454-05C-C5hi= OMNS 15454 Caombiner and Separ. g $3,000.00 0% $45,000.00 $45,000.00
15454-0FT-PRE= QM3 15454 Optical Pre-Amplifier .. 2 $40,000.00 0% $80,000.00 $80,000.00
15454-0PT-BET= OMS 15454 Optical Eooster Amplif... 3 $40,000.00 0% $120,000.00 $120,000.00
15454-AD-2C-54.1= OMNS 15454 OADM- 2 Chs - 100G 2 $30,000.00 0% $60,000.00 $60,000.00
16454-AD-2C-59.7= QM3 15454 OADM- 2 Chs - 100G 2 $30,000.00 0% $60,000.00 $60,000.00
15454-AD-4C-54 1= OMNE 15454 OADM- 4 Chs - 100G 4 $40,000.00 0% $160,000.00 $160,000.00 =
15454-AD-4C-58.1= OMNS 15454 OADM- 4 Chs - 100G 4 $40,000.00 0% $160,000.00 $160,000.00
16454-10T-L1-54.1= 10Ghs Transponder - 100Ghz- Tu g $75,000.00 0% $600,000.00 $600,000.00
15454-10T-L1-55.7= 10Ghbs Transponder - 100Ghz- Tu g §75,000.00 0% $600,000.00 $600,000.00
1‘5‘4__54-1 O0T-L1-58 10Ghs Transponder - 100Ghz- Tu g $75,000.00 0% $600,000.00 $600,000 T': :_

1 |

115802

To change the global discount for the entire network, enter a new global discount in the form of a
percentage in the Global Discount Percentage field. The field shows the percentage from the

Global Discount Percentage option in the Default Project Options window. The global discount is
applied to all components in the BOM.

To change the global discount percentage for an individual network component, click the

Network Unit Discount cell of the component you wish to change, and enter a new discount percentage.

Table 2-14 describes the columns.

[l Cisco MetroPlanner DWDM Operations Guide, Release 2.5

October 2004 |



| Chapter2

Designing Networks with MetroPlanner

2.9.2 Generating a Site BOM

Table 2-14 BOM Window Columns

Column Label Description

Shelf ID Displays the ID string of the shelf (for site BOMs only).
Product ID Displays the ID string of the product.

Description Displays a description of the product.

Quantity Displays the number of specific products in the BOM.
Unit Price Displays the price per unit.

Network/Site Unit
Discount

Displays the per unit discount amount that you assigned in the Global Discount
Percentage field. If you leave the field blank, the discount amount is zero.

Total Price

Displays the total price of the products before applying the discount.

Discounted Total
Price

Displays the total price of the products after applying the discount.

Site

Displays the number of products to be assigned to a particular site. The number
of Site columns is the same as the number of sites in the network.

2.9.2 Generating a Site BOM

Use the following steps to generate a BOM for a site.

Right-click on a site and select Generate Site BOM. The Site BOM window (Figure 2-58) appears.

[ october 2004
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Figure 2-58 Site BOM Window

Z Site 1 Bill of Material

Options
¥ B @ Messages T F 10-18-04 at 11:57 41
Site Total Discount Price: $932,435.00
Global Discount Percentage: 0%
Shelf ID Product ID | Quantity | Unit Price g:;it'::t ?ﬁg‘:‘;‘:ﬁ: |
Main Shelf iterns GF15454-MSTP-4 7 2 §000 0% $0.00
15454-METP-4.7 5= 1 §1885000 0% $1,095.00 |
154584-L0-L-2= 8 $90.00 0% $720.00/ |
Main Shelf 15454-54-HD= 1 $270000 0% $2,700.00 |
154584-L0-L-2= 2 $90.00 0% $180.00/ |
15454-L0-L0-2= 2 $90.00 0% $180.00 |
154584-L0-L-2= 2 $90.00 0% $180.00/ |
15454-L0-L0-2= 2 $90.00 0% $180.00 |
15454-TCC2 2 §4500000 0% $9,000.00 |
15454-FTAS-T 1 g72000 0% §720.00
15216-ATT-LG-12= 3 §200000 0% $600.00
16216-ATT-LC-10= 5 §20000 0% $1,000.00
15454-0FT-FRE= 2 §40,00000 0% $80,000.00
15454-05C-CEM= 1 $900000 0% $9,000.00
15454-0FT-B3T= 1 §40,00000 0% $40,000.00
15454-05CH= 1 §7.00000 0% $7,000.00
15454-AD-40-54 1= 2 §40,00000 0% $80,000.00 g
15454-A0-4C-58.1= 2 $40,000.00 0% $20,000.00 g

Step2  To change the discount percentage for a site component, click the Site Unit Discount cell of the
component you wish to change, and enter a new discount percentage.

Table 2-14 describes the columns.

2.9.3 Exporting a BOM

MetroPlanner allows you to export the BOM to an external file (such as an HTML or text file).

Step 1 Click Export. The Save Table dialog box appears.

Step2  Navigate to the destination folder and select or type the file name. MetroPlanner creates an HTML or
text file containing the BOM.

Step 3 Click Save. To cancel saving the BOM, click Cancel.

2.9.4 Importing a BOM to an Excel Spreadsheet

You can import a BOM that has been exported to a text file into a Microsoft Excel spreadsheet. For
information about creating BOM text files, see the “2.9.3 Exporting a BOM” section.

Step1  Launch the MicroSoft Excel application.
Step2  Select File > Open.
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Step3  Select the saved BOM file.
Step4  The BOM information appears in the Excel spreadsheet (Figure 2-59).

Figure 2-59 BOM in Microsoft Excel Example

E3 Miciosoft Excel - site2.txt

Type 3 question for help g

“hane
Sample design
Last Price Alignment Date: 04-16-04 at 11:20:32 via CCO Update

Site 2

Metwork Total Discount Price; . $122 415.00

Global Discount Percent 0%

cam.cisco.onet.ndt. metroplanner views ViewsUIFToolBarButton[ 2 131,77 %24 layout=javax.swing. OverlayLayout alignment¥=0.0,alignment V=0 5 border=javax. <

Shelf ID Product D Guantity Unit Price | Site Unit Discount Discounted Total Cost
15454-R4.6.05WCD 1 $1.995.00 0% $1,995.00
SF15454-R46.0 2 $0.00 0% $0.00

Main Shelf  15454-5A-ANSI 1 $2,700.00 0% §2,700.00
15454-LC-LC-2= 2 $90.00 0% $180.00
15454-TCC2 2| $4,500.00 0% $5,000.00

15454-FTA3-T 1 $720.00 0% $720.00

15216-ATT-LC-10= 1 $200.00 0% $200.00
15454-05C-CEM= 1) $9,000.00 0% $5,000.00
15454-AD-1C-58.1= 1) $20,000.00 0% $20,000.00

15454-10T-L1-58.1= 1) $75,000.00 0% §75,000.00

15454-BLANK 2 $225.00 0% $2,700.00

Air Rarp #0 15454-AIR-RAMP= 1 $120.00 0% $120.00

Fiber Storage 15454-FBR-STRG= 1 $800.00 $800.00

115833

Step5  To improve the formatting, increase the column widths.

2.9.5 Managing Network Spare Parts

After you generate the BOM, use the Spare Parts Manager to determine the spare parts required by the
network.

Step 1 Select Tools > Spares Management > Network Spare Parts. The Spare Parts Manager window
appears (Figure 2-60). To open the Spare Parts Manager window for a site, right-click the site and select
Manage Site Spare Part from the shortcut menu.
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Figure 2-60 Spare Parts Manager Window

',L‘IL‘.' Spare Parts Manager

Maintenance Center. MNone -
Site Name Site 2
Site Additional Spare List
Product Number of Spare
1D Oper. Units Quantity
Delete item
Add itern
Update BOM Spare Parts | | Export to File | | Close

115645

Step2  Click Add Item to add an item to the Network (Site) Additional Spare List area. An empty row appears

in the area.

Step3  Click the new row. The Spare Parts Manager List Dialog window (Figure 2-61) appears.

Figure 2-61 Spare Parts Manager List Dialog Window

',!,"g.'Spale Partz Manager List Dialog

tdajor Parent | Product | Description List Price |
QMG 15216 1521 6-ATT-LC-10= Bulk Aftenuatar - LC Connector-... $200.00 <
OMNE 15216 1521 6-ATT-LC-12= Bulk Attenuator - LC Connector -... $200.00 i
OMG 15216 15216-ATT-LC-15= Bulk Aftenuatar - LG Connectar - $200.00
OMG 15216 15216-ATT-LC-18= Bulk Aftenuatar - LG Connectar - $200.00
OMG 15216 1521 6-ATT-LC-2= Bulk Aftenuatar - LG Connectar - $200.00
OMG 15216 1521 6-ATT-LC-3= Bulk Aftenuatar - LG Connectar - $200.00
OMG 15216 1521 6-ATT-LC- Bulk Aftenuatar - LG Connectar - $200.00
OMG 15216 1521 6-ATT-LC-7= Bulk Aftenuatar - LG Connectar - $200.00
ONE 15216 15216-CS-Mh-v= Multi-Mode ¥ Cable Protection FI.. $2,300.00
ONE 15216 15216-CS-5M-v= Single-Mode ¥ Cable Protection ... $2,300.00
ONE 15216 15216-DCU-100= DCF af-100 psfnm $7,500.00
ONE 15216 15216-DCU-1150= DCF af -1150 pa/inm and 8dB lo... $29,787.00
ONE 15216 15216-DCU-350= DCF of -350 psfinm and 4dB loss $11,275.00
ONE 15216 15216-DCU-450= DCF of - 450 psinm $14,000.00
ONE 15216 15216-DCU-550= DCF af - 550 psinm $16,000.00
ONE 15216 15216-DCU-750= DCF of -750 pafinm and BdB loss  $20,531.00
ONE 15216 15216-DCU-950= DCF of - 950 psinm $24,000.00
ONE 15216 15216-DCLU-5A= Mechanical shelf thousing 2 DC.. $700.00
ONE 15216 15216-FL-5A= FlexLayer 4 Slat Shelf Assembly  $1,467.00
ONE 15216 15216-LC-LC-10= Fiher patchcord - LG to LG - G $90.00
ONE 15216 15216-LC-LC-20= Fiher patchcord - LG to LG - 8 $90.00
ONE 15216 15216-LC-LC-59= Fiher patchcord - LG to LG - 4 $90.00
ONE 15216 15216-LC-5C-10= Fiher patchcord - LG t0 5C - 6m $90.00
ONE 15216 15216-LC-5C-20= Fiher patchcord - LG 10 5C - Bm 90,00
ONE 15216 15216-LC-5C-5= Fiher patchcord - LG 10 5C - 4m 90,00 |
NbIS 15454 15454-10hd-1 1-20 3= 7 5 (3he - 105he Miended A0Gh 50 GO0 0 b
| 0Ok | | Search

115845

Step4  Select a product and click OK, or click Search to open the Find Item in Price List Table window

(Figure 2-62).
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Figure 2-62 Find Item in Price List Table Window

4l Find Item in Price List Table |

Find ¥What : || |

Lookin

M AllFields O Description O Product

115837

| Find || Cancel |

If you selected a product, it appears as a row in the Network (Site) Additional Spare List area. If you
clicked search, complete the following substeps:

a. Enter a search criteria in the Find What field.
b. Select All Fields, Description, or Product from the Look In area.

c¢. Click Find, or click Cancel to close the window without performing a search. The Spare Parts
Manager List Dialog window appears, with the item highlighted.

d. Select the product and click OK. The product appears as a row in the Network (Site) Additional
Spare List area.

Step 5 To delete the item, select the row and click Delete Item.

Step6  Click Update BOM Spare Parts to add the spare parts to the BOM. The BOM tab opens in the main
window, displaying the spare parts in the lower portion of the tab.

Step7  Click Export to File to save the list of spare parts to an external HTML or text file.

Step8  Click Close to close the Spare Parts Manager window.

2.9.6 Establishing Maintenance Centers

You can identify maintenance centers that will supply your network with spare parts in the event of a
failure. This feature helps your customer determine the quantity of spares that should be purchased,
depending on their maintenance centers and their availability.

Step 1 Select Tools > Spares Management > Maintenance Center List. The Maintenance Center List window
appears (Figure 2-63).
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Step 2
Step 3
Step 4

Step 5

Step 6
Step 7

Figure 2-63 Maintenance Centre List Window

1l W aintenance Centre list |
Centre Mame F = Frobahility to not find [ = Reparation/Replacing
the spare in maintenance centra ‘ time of faulty unit |
Resupply Depot a0 2
Alxillary Supply Ta 1
[
ok || Aw || Remove | cancel g

Click Add to add a maintenance center. A new row appears in the window.
Enter the center name in the Centre Name field.

Select the probability of finding the spare part in the selected maintenace center (represented by a
percentage) from the Probability field. Probabilities are 50%, 75%, 95%, and 99%.

Enter the approximate time it takes to stock a maintenance center with a part (represented in months) in
the Reparation/Replacing field.

To remove a maintenance center, select a center and click Remove.
Click OK.

2.9.7 Viewing Maintenance Center Assignments

Step 1

After creating and assigning maintenance centers, you can use the Network Maintenance Centres
Assignment window to view all the maintenance center assignments for each site in the network.

Select Tools > Spares Management > Maintenance Center Assignment. The Network Maintenance
Centres Assignment window appears (Figure 2-64).
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Figure 2-64 Network Maintenance Centres Assignment Window

tull Hetwork Maintenance Centres Assignment |
Site name | IF address | Maintenance Cenire |

Site 1 265.255.255.1
Site 2 265.255.265.2
Site 3 265.255.255.3
Site 4 265.255.255.4

=+

OK | | Cancel ]

The window displays the site name, IP address, and assigned maintenance center of each site.
Step2  To copy the information in the window, right-click any row and select Copy Table.

Step3  To export the information to an external file, right-click any row and select Export Table. A Save Table
window appears, allowing you to enter or select a file name for the exported information. You can save
maintenance center assignment files as either HTML or text files.

Step4  Click Save.

Step5  Click OK to close the Network Maintenance Centres Assignment window.
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CHAPTER

Modeled Network Examples

This chapter provides examples of typical optical networks you can model using MetroPlanner.
This chapter contains the following sections:

3.1 Supported MetroPlanner Topologies, page 3-1

3.2 Bus Topologies, page 3-1

3.3 Hubbed Ring Topology, page 3-3

3.4 Meshed Topology, page 3-3

3.1 Supported MetroPlanner Topologies

MetroPlanner 2.5 supports the following topologies:
e Bus (single span, point-to-point, and linear)
¢ Open (or hubbed) ring
¢ Closed (or meshed) ring

An example of each topology is given in this chapter.

3.2 Bus Topologies

Bus topologies are comprised of three different types of topologies: single span, point-to-point, and
linear.

3.2.1 Single-Span Topology

Figure 3-1 shows an example of a single-span topology. Single-span topologies are characterized by a
single span link. The single-span configuration only supports two terminal sites (full terminal or flexible
channel-count terminal) without any intermediate line amplifier or optical add/drop multiplexing
(OADM) sites.
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Figure 3-1 Single-Span Topology Example

Site 1
Site 2

1.0
0.25dB

115341

3.2.2 Point-to-Point Topology
Figure 3-2 shows an example of a point-to-point topology. In a point-to-point topology, all the

wavelengths are terminated at the same point in the chain. In the Point-to-Point configuration, no
channels are added or dropped in intermediate sites.

Figure 3-2 Bus Topology Example

Site 1

115918

3.2.3 Linear Topology

Figure 3-3 shows an example of a linear topology. Linear configurations are characterized by the
presence of two terminal sites (full terminal or flexible channel-count terminal). Between the two
terminal sites, OADM or line amplifiers nodes can be inserted. In a linear configuration, specific
wavelengths are terminated at different points in the chain and only unprotected traffic can be
provisioned.
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Figure 3-3 Linear Topology Example

Site 4

1158435

3.3 Hubbed Ring Topology

Figure 3-4 shows an example of a hubbed ring topology. In this configuration, at least one of the sites
must be a hub site, where all channels are terminated. In this diagram the hub is the Boulder site.

Figure 3-4 Hubbed Ring Topology Example

Eoulder

) South Parl
Colorado Springs /|

60.00 Km
15.00 dB
A6.00 Km

Denver

18.50 dB

115844

3.4 Meshed Topology

Figure 3-5 provides an example of a meshed ring topology. A meshed ring is characterized by the
absence of a hub node.
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3.4 Meshed Topology

Figure 3-5 Meshed Ring Topology Example

Boulder

=y, South Parlk

15.00dB |
A6.00 Km

Denver
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18.50 dB
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Card Types

This appendix provides a listing of card types and the corresponding Cisco card description (Table A-1).

Table A-1  Card Names and Protection

Protection
Product ID Card Type Type Card Name Card Description
15454-048E-1-xx.x 2.5-Gbps Client 1+1 |[OC-48 ELR-xx.Xx OC48 ELR/STM16 EH
(ANSI) ELR ITU-T (ANSI) 100 GHz - 15xx.xxnm
15454E-EL16HSxxxx STM16 EH-xx.x
(ETSI) (ETSI)
15454-MRP-L1-xx.x  [2.5G MR Client 1+1 |TXPP-MR-2.5G- 2.5-Gbps Multirate
(ANSI TXP w/FEC Y-Cable XX.X[xX.X] Transponder-Protected—
Fiber-Switched) (ISC-1 Not (Fiber-Switched) 100-GHz-Tunable

Fiber- ;
IS454E-MRP-1-xx.x | SUPPOTted) | DF ITXPMR-2.5G.  [FRANRRX
(ETSI Fiber-Switched) XX.X[XX.X] 2.5-Gbps Multirate
15454-MR-L1-xx.x iranilionder—IOO—GHz—
(ANSI) unable XX.XX-XX.XX
15454E-MR-1-xx.x ,2[)5((; NiR FEC Client 1+1
(ETSI) wio Y-Cable

(NoISC-1)

Fiber-

Switched

(NoISC-1)

2.5G MR Client 1+1
E/IXE 2R Y-Cable
ode (No

ETR/CLO)

(No ISC-3)

Fiber-

Switched

(No

ETR/CLO)

(No ISC-3)
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Table A-1  Card Names and Protection (continued)
Protection
Product ID Card Type Type Card Name Card Description
15454-192L-1-xx.x 10-Gbps LR |Client 1+1 |OC-192 LR-xx.x 0C192 LR/STM64 LH
(ANSI) ITU-T (ANSI) ITU 15xx.xx
15454E-64L-xXx.X STM-64 ELH-xx.x
(ETSI) (ETSI)
15454-10T-L1-xx.x 10G MR TXP |[Client 1+1 |TXP-MR-10G-xx.x |10-Gbps
(ANSI) w/FEC Y-Cable [xx.x] Transponder—100-GHz—
15454E-10T-xx.x 10G MR TXP Tunable xx.xx-xx.xx
(ETSI) w/o FEC
15454-10M-L1-xx.x 4x2.5-Gbps Client 1+1 [MXP-2.5G-10G- 2.5-Gbps—10-Gbps
(ANSI) MXP w/FEC Y-Cable XX.X[XX.X] Muxponder—100 GHz—
15454E-10M- xx.x  |4x2.5-Gbps Tunable xx.xx-xx.xx
(ETSI) MXP w/o
FEC
15454-DMP-L1-xx.x  |2.5G Data Client 1+1 |MXPP_MR_2.5G |2.5-Gbps Multirate
(ANSI MXP w/o Y-Cable -XX.X[xX.x] Muxponder-Protected—1
Fiber-Switched) FEC (Fiber-Switched) 00-GHz-Tunable
Fiber- -
15454E-DMP-1-xx.x Swimhed |MXPMR_25G- | 19X%xx-13yy.yy
(ETSI Fiber-Switched) XX.X[XX.X] 2.5-Gbps Multirate
15454-DM-L1-xx.x ?“X%‘l’nder' 100GHz-
(ANSI) unablie
15xx.xx-15yy.yy
15454E-DM-1-xx.X
(ETSI)
15454-10E-L1-xx.x 10G Enh MR |Client 1+1 |TXP_MR_10E- 10-Gbps
(ANSI) TXP w/EFEC Y-Cable XX.X[xX.X] Transponder—100-GHz—
15454E-10E-1-xxx  |10G Enh MR Enahnced-Tunable
(ETSI) TXP w/FEC HXXXXXXX
10G Enh MR
TXP w/o FEC
15454-10ME-xx.x 4x2.5-Gbps Client 1+1 |[MXP_2.5G_10E- 10-Gbps
(ANSI) Enh MXP Y-Cable XX.X[xX.X] Muxsponder—100-GHz—
15454E-10ME-xx.x w/EFEC Enahnced FEC-Tunable
(ETSI) 4x2.5-Gbps RXARXXKXX
Enh MXP
w/FEC
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Table A-1  Card Names and Protection (continued)
Protection
Product ID Card Type Type Card Name Card Description
15454-GBIC-xx.x GE Client 1+1 |WDM GBIC xx.x |GBIC xx.x WDM
(ANSI) Wavelength- 100GHz
15454E-GBIC-xx.x BIWIIS}O“
(ETST) ultt-
plexing
(WDM)
Gigabit
Interface
Converter
(GBIC)
15530-ITU2-xx10 10Gbps Client 1+1 |ONS 15530 Ch x ONS 15530 10-Gbps ITU
(w/splitter) Aggregation Fiber- 10-Gbps ITU Trunk |Trunk Card with splitter
15530-ITU2-xx20 (w /splitter) | g iiched/ gaqu MU w/ ONS 15530 10-Gbps ITU
(non-splitter) 10Gbps Splitter plitter Trunk Card wihtout
Aggregation ONS 15530 Ch x splitter
10-Gbps ITU Trunk
Card MU w/o
Splitter
15530-ITU3-xx10 2.5Gbps Client 1+1 |15530-ITU3-xx10 |ONS 15530 Ch x/y
(w/splitter) Agfregla.ltlon Fiber- 15530-ITU3-xx20 éS-(?ll\)/ﬁsj IT/USTlr'unk
15530-ITU3-xx20 (w /splitter) g it ched/ ar w/ Splitter
(non-splitter) 2.5Gbps Splitter ONS 15530 Ch x/y
Aggregation 2.5-Gbps ITU Trunk
Card MU w/o Splitter
15530-TSP1-xx11 MR MM Client 1+1 |15530-TSP1-xx11 |ONS 15530 Transponder
(MM w/splitter) ’(I‘ra;lsp;).rtltdei Y-Cable 15530-TSP1-xx12 Cl/l X/i/-t-t 1310nm MM SC
} ) w / splitter w/ splitter
15530-TSP1-xx12(SM Fiber-  |15530-TSP1-xx21
w/splitter) MR SM . ONS 15530 Transponder
Transponder Switched/ |1 5530.T3p1-xx22 Ch x/y - 1310nm SM SC
15530-TSP1-xx21 } Pl, Splitter ) 1y
(MM non-splitter) (w / splitter) w/ splitter
MR MM ONS 15530 Transponder
15530-TSP1-xx22 (SM
. xx22( Transponder Ch x/y - 1310nm MM SC
non-splitter) /o soli
MR SM w/o splitter
Transponder ONS 15530 Transponder
Ch x/y - 1310nm SM SC
w/o splitter
15530-MSMP-xx12 Data Client 1+1 [15530-MSMP-xx12 |MR Data Muxponder (w/
(w/splitter) Mu/xpolr.lder Fiber- 15530-MSMP-xx22 splitter)
15530-MSMP-xx22 | W/ sPlitten) Iq ot hed/ MR Data Muxponder
(non-splitter) Data Splitter (w/o splitter)
Muxponder
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APPENDIX

Troubleshooting

This appendix lists system messages. It also describes problems you might encounter using
MetroPlanner and their possible solutions. This chapter contains the following sections:

B.1 System Messages, page B-1
B.2 Traffic Mapping Troubleshooting, page B-3
B.3 Amplifier and DCU Placement Troubleshooting, page B-5

B.1 System Messages

Table B-1 displays a list of MetroPlanner system messages and severities.

Table B-1  Error Messages

Area Severity Message
General Error Resulting network design has channels with
shortcoming in TX-RX (at least one channel with red
alarm)
Error Process interrupted by user
Traffic Mapping Error Network not feasible. All solutions exceeds system
capacity of 32 wavelengths
Error Maximum wavelength re-usage reached for channels
with wavelength [wavelength]
Error Two protected services assigned to the same
wavelength
Error Overlapped services assigned to the same wavelength
Error Can't route service with hitless: [service name]
Error Can't find alternate route for service: [service name]

due to multiple HUB nodes along the path

Error Can't route service: [service name] through HUB node
defined in site [Site Name]
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I B.1 System Messages

Table B-1 Error Messages (continued)

Area Severity Message
Common (MetroCore Error Span between site [Site Name] and [Site Name] is too
MetroAccess) long for OSC channel. Network unfeasible
Error Span between site [Site Name] and [Site Name] is too
long for OSC channel. Try to remove
PASS-THROUGH suggestion from site [Site Name]
Error Span between site [Site Name] and [Site Name] is too
long for OSC channel. Try to unfreeze site [Site Name]
Error [West/East] channel power in [Site Name] is near or
.. |below the fail low threshold
(In case power in is
below)
Error Unfeasible Network design. [Site Name] should
require usage of in-line attenuator
MetroCore Error [West/East] [PRE/BST] amplifier in [Site Name] is
working with a gain over [Gain Limit] dB
Error Excessive span between [Site Name] and [Site Name]
Error Excessive span and too much channels between [Site
Name] and [Site Name]
Error Dispersion compensation over limit. Try to unfreeze
site [Site Name]
Error Dispersion compensation over limit. Try to unlock
PRE in site [Site Name]
Error [PRE/BST] amplifier in [Site Name] [West/East] side
is set to work in output power control mode
Error Dispersion compensation over limit. System needs
custom design due to fibre before [Site Name]
MetroAccess Error Network not feasible: Exceeded 120 km
Error Network not feasible: Exceeded maximum amount of
chromatic dispersion for at least one of the network
connections
Error Network not feasible: Available amplification is not
sufficient for the power budget requirements
Error Network not feasible: No valid solutions found, with at

maximum 5 amplifiers per sub-network
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Table B-1 Error Messages (continued)

B.2 Traffic Mapping Troubleshooting W

Area Severity Message

General Warning Resulting Network design has some channel with
shortcoming in TX-RX (at least one channel with
yellow alarm)

Warning Resulting Network design has some channel with
shortcoming in TX-RX (at least one channel with
orange alarm)

Warning BOM does not contain any SFP module for the 2R Any
Rate Client Service Type. Without SFP plug in, the
board cannot work and it will be responsibility of the
user adding the SFP as spare part

Warning In site [Site Name], multimode patch-cords between
client port of transponder and Y-Cable module are not
in BoM

Common Warning [West/East] channel power in [Site Name] is near or
. . |below the fail low threshold

(In case power in is

near)

MetroCore Warning In [Site Name], [Dir: CW/CCW] direction a fixed
attenuator of [Att. Value] dB is needed

Warning In [Site Name], [Dir: CW/CCW] direction, before PRE
amplifier, a fixed attenuator of [Att. Value] dB is
needed

Warning VOA loops exhausted without stabilization...

Warning PMD warning on service [Service Name]

General Info The generated BOM does not include SONET/SDH
units

Traffic Mapping Info No specific anti-ASE node is required for this traffic
matrix requirement.

Info Additional OADM ports added in Node XX for

Anti-ASE: some channels in Optical Bypass.

B.2 Traffic Mapping Troubleshooting

Traffic mapping troubleshooting encompasses problems that directly relate to network traffic.

B.2.1 Unfeasible Network

Symptom : Network not feasible. All the solutions exceed system capacity of 32, 16, or 8 wavelengths.

Table B-2 describes the potential causes of the symptom and the solution.

[ october 2004

Cisco MetroPlanner DWDM Operations Guide, Release 25 g



Appendix B Troubleshooting |

I B.2.2 Automatic Full-OADM NE Site Definition

Table B-2 Unfeasible Network—System Capacity Exceeded

Possible Problem Solution

Some span in the ring  |Remove all the forced routing direction on unprotected channels.
must carry more than
32 wavelengths to
implement the traffic
demands.

Some span in the ring | Try changing the Project Options > Analyzer algorithm and check for
must carry more than feasibility.
16/8 wavelengths

Symptom : Network not feasible. Overlapped services assigned to the same wavelength.

Table B-3 describes the potential causes of the symptom and the solution.

Table B-3 Unfeasible Network—Overlapped Services

Possible Problem Solution

Some unprotected Remove pre-assigned directions and/or wavelengths on the specific
channels with assigned |channels.

wavelengths and
directions overlap along
the ring.

B.2.2 Automatic Full-OADM NE Site Definition

Symptom : MetroPlanner automatically generated full optical add/drop multiplexing (OADM) nodes,
even though they were not explicitly requested by the user.

Table B-4 describes the potential causes of the symptom and the solution.

Table B-4 Automatic Full-OADM Node Site Definition

Possible Problem Solution
Full-OADM layout automatic definition can occur Avoid forcing wavelengths for connections
under the following circumstances: from/to the node and forcing directions on

unprotected channels (keep the default,
which optimizes the routing and coloring
processes).

e Large capacity nodes (adding/dropping more than
12 wavelengths per side or more than
16 wavelengths in one side) are implemented using
full-OADM node configuration for cost and layout |For a small capacity node, try to force the
efficiency. full-OADM site as Passive OADM (that has

e Small capacity nodes requiring more than 4 OADM 3 slots available for x sides).

units in one side are implemented with full-OADM.
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B.2.3 Unfeasible Unprotected Service Circuits

B.2.3 Unfeasible Unprotected Service Circuits

Symptom : Some circuit channels have negative optical signal-to-noise ratios (OSNRs) and/or power

margins.

Table B-5 describes the potential cause of the symptom and the solution.

Table B-5 Unfeasible Unprotected Service Circuits

Possible Problem

Solution

The connection exceeds the optical target span budget.

Try to force the connection direction in
order to route it on the other ring direction.

B.3 Amplifier and DCU Placement Troubleshooting

The amplifier and DCU placement algorithm is iterative and its convergence can depend on the initial

state the optimizer is run against.

B.3.1 Unfeasible Service Circuits

Symptom : The user forced one or more nodes as Passive OADM, and some connections are unfeasible.

Table B-6 describes the potential cause of the symptom and the solutions.

Table B-6 Unfeasible Service Circuits

Possible Problem

Solution

You cannot make the passive OADM forced node
passive (excessive loss) for performance reasons.
MetroPlanner attempts to place an amplifier in the node,

but cannot because the node was forced to be an passive
OADM.

¢ Undo the forced passive OADM and
allow the optimization process in the
node. Then run the analyzer again.

e Force an amplifier (such as a booster)
in the previous node (if not already
present). Then run the analyzer again.

Note  You should force the amplifier in
both the clockwise and
counterclockwise directions.

B.3.2 Exhausted VOA Loop

Symptom : MetroPlanner generates a warning stating that the system requires an inline bulk attenuator,

but the exact value of the attenuator will not be given as an output.

Table B-7 describes the potential causes of the symptom and the possible solutions.
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M B.3.3 Network Requires Custom Design

Table B-7 Exhausted VOA Loop

Possible Problem Solution

The maximum number of amplifier and dispersion There are two possible solutions:
compensation unit (DCU) placement algorithm

. . ¢ If there are no channels with negative
iterations has been reached.

margins, disregard the warning and do
nothing.

e If at least one channel has negative
margins, try one of the following
actions:

— Try to force the preamplifiers in
the transmit (Tx) node of the failed
channels and run the analyzer
again.

— Look at the system specification
and determine whether the system
is feasible. If so, find the path of
the channel with the worst OSNR
margin and force an amplifier in
the first passive location starting
from the Tx node and run the
analyzer again.

B.3.3 Network Requires Custom Design

Symptom : MetroPlanner warns you that the system requires a custom design.

Table B-8 describes the potential cause of the symptom and the solution.

Table B-8 Network Requires Custom Design

Possible Problem Solution

Network requires a custom design due to mixed fibers |Contactyour Cisco representative to receive
traversed by service <ServiceX> a custom network design.

B.3.4 Dispersion Check Warning

Symptom : MetroPlanner issues a dispersion check error.

Table B-9 describes the potential cause of the symptom and the solution.
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B.3.5 Using 32 Channel DMX-0 with Bulk Attenuators Option Disabled [l

Table B-9 Dispersion Check Warning

Possible Problem Solution
MetroPlanner generates a dispersion check error for the |Attempt to lock a preamplifier in the first
following possible reasons: previous free site in the path of the failed
¢ You forced a site to a specific type, preventing the channel.
placement of a preamplifier. The analyzer requires
a preamplifier on this site.
e The dispersion check failed in a site where a
preamplifier is already present.
Dispersion check failed in Install mode where the Try unfreezing the first or the last
dispersion of the previous span was modified. preamplifier along the failing service.

B.3.5 Using 32 Channel DMX-0 with Bulk Attenuators Option Disabled

Symptom : MetroPlanner generates the following message: “MetroPlanner tried to use the 32Chs DMX

but this unit is not suitable in this network; try allowing the use of bulk attenuators or select the 32Chs
DMX-O”.

Table B-10 describes the potential cause of the symptom and the solution.

Table B-10 Disabled Bulk Attenuators Option

Possible Problem Solution

The user has disabled the use of bulk attenuators. | ® Enable the bulk attenuators at the 32 DMX
The channels experience large power tilt. output ports.

e Try to lock amplifiers (boosters in line sites,
for example) to reduce tilt.

e Select 32 DMX-O.

B.3.6 The 32 Channel DMX Not Suitable due to Excessive Channel Tilt

Symptom : MetroPlanner generates the following message: “Due to excessive channel tilt, the 32Chs
DMX is not suitable in this network; try unlocking an amplifier or select the 32Chs DMX-0".

Table B-11 describes the potential cause of the symptom and the solution.

Table B-11 Excessive Channel Tilt

Possible Problem Solution

The channel tilt cannot be recovered with the use | ® Try to lock amplifiers (boosters in line sites,
of bulk attenuators at the DMX output, due to for example) to reduce tilt.
large channel power variations as the number of

. lect 32 DMX-O.
installed channels is varied. Select 3 o
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I B.3.6 The 32 Channel DMX Not Suitable due to Excessive Channel Tilt
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